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​Basic Computer Operating Skills​

​Unit 1: Computer Fundamentals​

​INTRODUCTION OF COMPUTER:​

​The​ ​word​ ​“computer”​ ​comes​ ​from​ ​the​​word​​“TO​​COMPUTE”​​which​​means​
​to​ ​calculate.​ ​A​ ​computer​​is​​normally​​considered​​to​​be​​a​​calculation​​device​
​which can perform the arithmetic operations very speedily.​
​A​ ​computer​ ​may​ ​be​ ​defined​ ​as​ ​a​ ​device​ ​which​ ​operates​ ​upon​ ​the​ ​data.​
​Data​​can​​be​​in​​the​​form​​of​​numbers,​​letters,​​symbols,​​size​​etc.​​And​​it​​comes​
​in​ ​various​ ​shapes​ ​&​ ​sizes​ ​depending​ ​upon​ ​the​ ​type​ ​of​ ​computer​
​application.​
​Charles​ ​Babbage​ ​is​ ​the​ ​"Father​ ​of​ ​the​ ​Computer".​ ​He​ ​was​ ​an​ ​English​
​mathematician,​ ​philosopher,​ ​and​ ​inventor​ ​who​ ​designed​ ​the​ ​first​
​mechanical computer called the Analytical Engine in the 1830s.​

​What is Computer:​

​A​ ​computer​ ​is​ ​an​ ​electronic​ ​device​ ​which​ ​takes​ ​input​ ​from​ ​the​ ​user,​
​processes it and gives the output as per user’s requirement.​

​●​ ​A​ ​computer​ ​first​ ​gets​ ​the​ ​Input,​ ​does​ ​Process​ ​on​ ​it​ ​and​ ​then​
​produces Output.​
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​Key Points:​
​●​ ​Accepts input, processes data, gives output​
​●​ ​Fast, accurate, and reliable​
​●​ ​Stores large amounts of data​

​Generation of Computer:​
​The​ ​history​ ​of​ ​computers​ ​is​ ​divided​ ​into​ ​five​ ​generations​ ​based​ ​on​ ​the​
​technology​ ​used.​ ​Each​ ​generation​ ​brought​ ​new​ ​improvements​ ​in​ ​size,​
​speed, cost, and functionality.​

​1. First Generation (1940–1956) – Vacuum Tubes:​
​●​ ​These computers used vacuum tubes for processing.​
​●​ ​They were very large and consumed a lot of electricity.​
​●​ ​They were slow and produced a lot of heat.​
​●​ ​Example: ENIAC, UNIVAC​

​2. Second Generation (1956–1963) – Transistors:​
​●​ ​These computers used transistors instead of vacuum tubes.​
​●​ ​They​ ​were​ ​smaller,​ ​faster,​ ​and​ ​more​ ​reliable​ ​than​ ​first-generation​

​computers.​
​●​ ​They produced less heat and used less power​
​●​ ​Example: IBM 1401, CDC 1604​

​3. Third Generation (1964–1971) – Integrated Circuits (ICs):​
​●​ ​Used small chips called Integrated Circuits​​.​
​●​ ​Much​ ​smaller,​ ​cheaper,​ ​and​ ​faster​ ​than​ ​second-generation​

​computers.​
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​●​ ​Supported multiple applications at the same time.​
​●​ ​Example: IBM 360, PDP-8​

​4. Fourth Generation (1971–Present) – Microprocessors:​
​●​ ​Used microprocessors – a single chip that does all computing work.​
​●​ ​These are modern computers like laptops and desktops.​
​●​ ​They are fast, small, and affordable for everyone.​
​●​ ​Example: Intel 4004, Core i7​

​5. Fifth Generation (Present and Future) – Artificial​
​Intelligence (AI):​

​●​ ​These computers use Artificial Intelligence and machine learning.​
​●​ ​They can understand, think, and make decisions like humans.​
​●​ ​Used in robotics, smart assistants, self-driving cars, and more.​
​●​ ​Example: Siri, Google Assistant, AI Robots​

​Characteristics of a computer:​

​Some important characteristics of the computer are as follow:​

​1. Speed:​
​●​ ​A computer works very fast.​
​●​ ​It can perform millions of tasks in a second.​
​●​ ​Example: It can add big numbers within a fraction of a second.​

​2.  Accuracy:​
​●​ ​A computer gives correct results.​
​●​ ​Mistakes​ ​are​ ​usually​ ​due​ ​to​ ​wrong​ ​input​ ​or​ ​instructions​ ​given​ ​by​

​humans.​

​3. Automation:​

​●​ ​Once​ ​you​ ​give​ ​the​ ​instructions​ ​(program),​ ​the​ ​computer​ ​works​
​automatically. No need to give instructions again and again.​

​4. Multitasking​
​●​ ​A computer can do many tasks at the same time.​
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​●​ ​Example:​ ​You​ ​can​ ​type​ ​a​ ​document,​ ​listen​ ​to​ ​music,​ ​and​ ​download​
​files together.​

​5. Storage​
​●​ ​A computer can store a large amount of data.​
​●​ ​You can save text, images, videos, and much more for a long time.​

​Types of Computers:​

​Computers​ ​are​ ​different​​types​​based​​on​​their​​size,​​power,​​and​​usage.​​Here​
​are the main types:​

​1. Super computer​
​A​​supercomputer​​is​​a​​very​​fast​​and​​powerful​​computer.​​It​​can​​do​​millions​​of​
​tasks​ ​in​ ​one​ ​second.​ ​Supercomputers​ ​are​ ​much​ ​faster​ ​than​ ​normal​
​computers.​

​●​ ​Fastest and most powerful computers.​
​●​ ​Used for weather forecasting, space research, scientific simulations.​

​2. Mainframe Computer​

​A​ ​mainframe​ ​computer​ ​is​ ​a​ ​large​ ​and​ ​powerful​ ​computer​ ​used​ ​by​ ​big​
​companies​ ​and​ ​government​ ​offices.​ ​It​ ​can​ ​handle​ ​many​ ​users​ ​and​ ​large​
​amounts of data at the same time.​
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​●​ ​Very big and powerful.​
​●​ ​Can support hundreds or thousands of users at the same time.​
​●​ ​Used by banks, railways, big companies.​

​3. Mini Computer​

​A​ ​minicomputer​ ​is​ ​a​ ​medium-sized​ ​computer​ ​used​ ​by​ ​small​ ​businesses​
​and​ ​organizations.​ ​It​ ​can​ ​handle​ ​multiple​ ​users​ ​at​ ​the​ ​same​ ​time​ ​and​ ​is​
​used for business tasks and data processing.​

​●​ ​Smaller than mainframe computers but still powerful.​
​●​ ​Used in small companies, organizations, or departments.​
​●​ ​Supports many users but fewer than mainframes.​

​4. Microcomputer (Personal Computer)​

​A​ ​microcomputer​ ​is​​a​​small,​​affordable​​computer​​used​​by​​one​​person​​at​​a​
​time. It is also called a personal computer (PC).​
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​●​ ​Commonly used by individuals.​
​●​ ​Also called PC (Personal Computer).​
​●​ ​Used at home, schools, offices.​
​●​ ​Types of Microcomputers:​

​⮚​ ​Desktop​
​⮚​ ​Laptop​
​⮚​ ​Tablet​
​⮚​ ​Smartphone​

​Use of Computers in Various Fields:​

​Computers​ ​are​ ​used​ ​in​ ​almost​ ​every​ ​field​ ​today.​ ​They​ ​help​ ​us​ ​to​ ​do​ ​work​
​faster,​ ​more​ ​accurately,​ ​and​ ​with​ ​less​ ​effort.​ ​Let’s​ ​look​ ​at​ ​how​ ​computers​
​are used in different areas:​

​1. Education​
​●​ ​Used in schools and colleges for learning and teaching.​
​●​ ​Helps​ ​students​ ​to​ ​study​ ​through​ ​online​ ​classes,​ ​videos,​ ​and​

​educational software.​
​●​ ​Used for creating question papers and report cards.​

​2. Office Work​
​●​ ​Used for typing documents, emails, and presentations.​
​●​ ​Helps in managing data, records, and communication.​
​●​ ​Saves time and improves efficiency.​

​3. Hospitals and Health Care​
​●​ ​Helps doctors in checking patients and doing surgeries.​
​●​ ​Used for keeping medical records and reports.​
​●​ ​Used in scanning machines (CT scan, MRI).​

​4. Banking​
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​●​ ​Used​​for​​money​​transfers,​​ATM​​machines,​​and​​maintaining​​customer​
​accounts.​

​●​ ​Helps in online banking and digital payments.​

​5. Business​
​●​ ​Used in billing, inventory, sales reports, and online shopping.​
​●​ ​Helps manage accounts and customer service.​

​Parts of computer:​

​A​ ​computer​ ​is​ ​made​ ​up​ ​of​ ​different​ ​parts​ ​that​ ​work​ ​together​ ​to​ ​perform​
​tasks.​ ​These​ ​parts​ ​are​ ​mainly​ ​divided​ ​into​ ​two​ ​categories:​ ​Hardware​ ​and​
​Software.​

​1. Hardware:​
​Hardware​ ​refers​ ​to​ ​the​ ​physical​ ​parts​ ​of​ ​a​ ​computer​ ​that​ ​we​ ​can​ ​see​​and​
​touch.​
​Examples​​: Monitor, Keyboard, Mouse, CPU, Printer,​​Speakers, Hard Disk,etc.​

​2. Software:​
​Software​ ​refers​ ​to​ ​the​ ​set​ ​of​ ​instructions​ ​or​ ​programs​ ​that​ ​tell​ ​the​
​computer​ ​what​ ​to​ ​do.​ ​We​ ​cannot​ ​touch​ ​software​ ​it​ ​only​ ​works​ ​inside​ ​the​
​computer.​

​Examples: Windows, MS Word, Paint, Google Chrome, Games, etc.​
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​What is Device in a computer?​

​A​ ​device​ ​in​ ​a​ ​computer​ ​refers​ ​to​ ​any​ ​hardware​ ​component​ ​that​ ​helps​ ​in​
​input,​ ​processing,​ ​output,​ ​or​ ​storage​​of​​data.​​These​​devices​​are​​connected​
​to the computer and work together to complete tasks.​

​Types of Devices in Computer:​
​Computer devices are mainly divided into Three types:​

​1. Input Devices:​
​These devices are used to enter data and instructions into the computer.​
​Examples:​

​●​ ​Keyboard – to type text​
​●​ ​Mouse – to click and move the pointer​
​●​ ​Scanner – to scan documents​
​●​ ​Microphone – to record sound​

​2. Output Devices:​

​These devices are used to display or show results of processed data.​
​Examples:​

​●​ ​Monitor – to display text and images​
​●​ ​Printer – to get printed copy (hard copy)​
​●​ ​Speakers – to hear sound​
​●​ ​Projector – to display screen on a wall​
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​3. Storage Devices:​
​Storage​ ​devices​ ​are​ ​hardware​ ​used​ ​to​ ​store​ ​data,​ ​files,​ ​and​ ​programs​ ​in​ ​a​
​computer.​ ​These​ ​devices​ ​help​ ​us​ ​save​ ​information​ ​permanently​ ​or​
​temporarily.​

​Examples:​

​Type​ ​Examples​ ​Use​
​Primary​
​Storage​

​RAM, Cache​ ​Temporary​ ​storage​ ​used​ ​while​
​computer is on​

​Secondary​
​Storage​

​Hard Disk, SSD​ ​Permanent​ ​storage​​for​​programs​​and​
​files​

​Portable​
​Storage​

​PenDrive, CD/DVD​ ​Easy​​to​​carry​​and​​move​​data​​between​
​devices​

​Cloud Storage​ ​GoogleDrive,​
​OneDrive​

​Online storage using internet​

​Activity:​ ​Group​ ​Assessment​ ​based​ ​on​ ​computer​ ​Fundamentals​ ​(team​
​based)​
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​Unit 2 Operating System​

​What is an Operating System?​

​An​ ​Operating​ ​System​ ​(OS)​ ​is​ ​a​ ​system​ ​software​ ​that​ ​controls​ ​all​ ​the​
​working​ ​of​ ​a​ ​computer.​ ​It​ ​acts​ ​as​ ​a​ ​manager​ ​between​ ​the​ ​computer​
​hardware​ ​(like​ ​CPU,​ ​keyboard,​ ​mouse,​ ​printer)​ ​and​ ​the​ ​user.​ ​Without​ ​an​
​operating system, a computer cannot function.​
​When​ ​you​ ​turn​ ​on​ ​your​ ​computer,​​the​​first​​program​​that​​starts​​running​​is​
​the​​operating​​system.​​It​​manages​​files,​​runs​​software​​programs,​​and​​allows​
​the user to interact with the system using graphical or text interfaces​​.​

​Types of​​Operating Systems​

​There​ ​are​ ​many​ ​types​ ​of​ ​operating​ ​systems​ ​depending​​on​​the​​device​​and​
​usage​​some​​are​​Batch​​Operating​​System,​​Time-Sharing​​Operating​​System,​
​Distributed​ ​Operating​ ​System,​ ​Network​​Operating​​System​​(NOS).​​The​​four​
​most common examples are:​

​Type​ ​Details​
​Windows​ ​Developed​ ​by​ ​Microsoft,​ ​Windows​ ​is​ ​the​ ​most​ ​widely​ ​used​

​OS​ ​in​ ​desktops​ ​and​ ​laptops.​ ​It​ ​has​ ​a​ ​user-friendly​ ​Graphical​
​User Interface (GUI). Examples: Windows 10, Windows 11.​

​Linux​ ​Linux​ ​is​ ​a​ ​free​ ​and​ ​open-source​ ​operating​ ​system,​ ​mainly​
​used​​by​​programmers​​and​​servers.​​It​​is​​known​​for​​its​​security,​
​speed, and flexibility. Popular versions: Ubuntu, Fedora.​

​Android​ ​Android​ ​is​ ​an​ ​operating​ ​system​ ​designed​ ​for​ ​smartphones​
​and​ ​tablets.​ ​It​ ​is​ ​developed​ ​by​ ​Google​ ​and​ ​supports​ ​apps​
​from the Play Store.​
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​Importance of an Operating System​
​The​ ​OS​ ​is​ ​the​ ​most​ ​important​ ​software​ ​on​ ​a​ ​computer.​ ​Here's​ ​why​ ​it​ ​is​
​essential:​

​1.​ ​Make​ ​the​ ​computer​ ​usable​ ​–​ ​Without​ ​it,​ ​we​ ​cannot​ ​use​ ​the​
​computer.​

​2.​ ​Manages​ ​software​ ​and​ ​hardware​ ​–​ ​It​ ​makes​ ​sure​ ​all​ ​parts​ ​of​ ​the​
​computer work together.​

​3.​ ​Provides​ ​interface​ ​–​ ​It​ ​gives​ ​us​ ​a​ ​platform​ ​(like​ ​desktop​ ​or​ ​mobile​
​screen) to interact with the computer.​

​4.​ ​Runs​ ​applications​ ​–​ ​It​ ​runs​ ​all​ ​the​ ​programs​ ​like​ ​MS​ ​Word,​ ​Excel,​
​Browsers, Games, etc.​

​5.​ ​Ensures security – It keeps our data safe from unauthorized access.​

​Functions of Operating System​

​Function​ ​Detailed Description​

​1.Memory​
​Management​

​The​ ​OS​ ​manages​ ​the​ ​RAM​ ​(Random​ ​Access​
​Memory)​ ​and​ ​allocates​ ​memory​ ​to​ ​each​ ​running​
​program. It also frees up memory when not needed​

​2.Process​
​Management​

​It​ ​keeps​ ​track​ ​of​​all​​active​​applications​​or​​processes.​
​It​ ​ensures​ ​that​ ​each​ ​process​ ​gets​​enough​​time​​and​
​resources.​

​3. File Management​ ​It​ ​helps​​in​​creating,​​saving,​​deleting,​​and​​organizing​
​files​ ​and​ ​folders​ ​on​ ​the​ ​storage​ ​device​ ​like​ ​a​ ​hard​
​disk.​

​4.Device​
​Management​

​It​ ​controls​ ​all​ ​input​ ​and​ ​output​ ​devices​ ​like​
​keyboard,​ ​mouse,​ ​printers,​ ​scanners,​ ​etc.,​ ​through​
​device drivers.​

​5.Security​
​Management​

​The​ ​OS​ ​protects​ ​files​ ​and​ ​data​ ​by​ ​using​ ​passwords,​
​permissions, antivirus support, etc.​
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​Example Scenario:​
​Suppose you are typing a document in MS Word:​

​●​ ​The OS is helping you by running MS Word,​
​●​ ​Storing your file on the hard disk,​
​●​ ​Taking input from your keyboard,​
​●​ ​Sending print commands to the printer,​
​●​ ​And ensuring everything works together smoothly​​.​

​Shiv Nadar Institution of Eminence​ ​16​​|​​Page​
​Deemed to be University​



​Unit 3 How to manage File​

​What is a File and Folder?​

​File:​ ​A​ ​file​ ​is​ ​a​ ​collection​ ​of​ ​data​ ​or​ ​information​ ​stored​ ​on​ ​a​ ​computer.​ ​It​
​can be a document, image, video, audio, or program.​

​●​ ​Examples​​: MyDocument.docx, Photo.jpg, Song.mp3​

​Folder:​ ​A​ ​folder​ ​is​ ​like​ ​a​ ​container​ ​used​ ​to​ ​organize​ ​files.​ ​It​ ​helps​ ​group​
​related files together.​

​●​ ​Example:​ ​A​ ​folder​ ​named​ ​"School​ ​Work"​ ​can​ ​contain​ ​files​ ​like​
​MathHomework.docx or ScienceProject.pptx.​

​How to Create, Save, and Delete Files and Folder​
​1. How to Create a Folder:​
​Step 1:​​Go to​​Desktop​​or​​any folder​​.​
​Step 2:​​Right-click​​on empty space.​
​Step 3:​​Click​​New​​→ then click​​Folder​​.​
​Step 4:​​Type the name you want.​
​Step 5:​​Press​​Enter​​.​
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​2. How to Create a File:​

​Step 1:​​Right-click on the desktop or inside a folder.​
​Step​ ​2:​ ​Choose​ ​New​ ​→​ ​select​ ​the​ ​type​ ​of​ ​file​ ​(e.g.,​ ​Word​ ​Document,​ ​Text​

​File).​
​Step 3:​​Give a name and press Enter.​

​2. How to Save a File:​

​When working in an application like MS Word:​
​Step 1:​​Click on File → Save or Save As​
​Step 2:​​Choose the location (like Desktop or Documents).​
​Step 3:​​Enter a name and click Save.​

​3. How to Delete a File:​

​Step 1:​​Right-click the file or folder.​
​Step 2: Click Delete.​
​The file will move to the Recycle Bin.​
​To delete permanently, empty the Recycle Bin.​

​Importance of Organizing Files​

​●​ ​Makes it easier to find important documents.​
​●​ ​Saves time and effort.​
​●​ ​Keeps the computer neat and clean.​
​●​ ​Helps in better productivity and work management.​
​●​ ​Reduces chances of losing important data.​

​Tips for organizing:​

​●​ ​Create folders for each subject or project.​
​●​ ​Name files clearly (e.g., Class6_Maths_Homework.docx).​
​●​ ​Delete unwanted files regularly.​
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​Example: How to Organize Files​
​Let’s​ ​say​ ​you​ ​are​ ​a​ ​student​ ​and​ ​have​ ​many​​files​​for​​different​​subjects.​​You​
​can organize like this:​

​📁​​Class 9​​(Main Folder)​
​   ​​📁​​English​
​      ​​📄​​Essay.docx​
​      ​​📄​​GrammarNotes.pdf​
​   ​​📁​​Maths​
​      ​​📄​​Formulas.xlsx​
​      ​​📄​​Algebra.pdf​
​   ​​📁​​Science​
​      ​​📄​​Experiment.docx​
​      ​​📄​​Diagram.png​
​Activity:​
​Create folders for school subjects and save the files​
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​Unit 4 MS Word​

​INTRODUCTION OF MS WORD​

​●​ ​Charles​ ​Simonyi,​ ​a​ ​developer​ ​and​ ​Richard​ ​Brodie,​ ​a​ ​software​
​engineer, were the two creators of MS Word​

​●​ ​This​ ​program​ ​was​ ​initially​ ​named​ ​“multi-Tool​ ​Word”​ ​but​ ​later,​ ​was​
​renamed as MS Word​

​●​ ​It was introduced in 1983​
​●​ ​Word​ ​for​ ​Windows​ ​is​ ​available​ ​standalone​ ​or​ ​as​ ​a​ ​part​ ​of​ ​MS​ ​Office​

​suite​
​●​ ​MS Word for Mac was introduced by Microsoft as Word 1.0 in 1985​
​●​ ​The extension for any word file is “.doc or .docx.”​

​What is MS Word?​
​MS​ ​Word​ ​(Microsoft​ ​Word)​ ​is​ ​a​ ​computer​ ​program​ ​used​ ​to​ ​type​ ​and​
​format​​text​​like​​letters,​​essays,​​stories,​​notes,​​applications,​​and​​reports.​​It​​is​
​a part of​​MS Office​​.​

​Why Do We Use MS Word?​

​●​ ​To​​write and edit​​text​
​●​ ​To​​change font, colour, and style​
​●​ ​To​​insert pictures, tables, and shapes​
​●​ ​To​​print documents​

​Main Features of MS Word:​
​Feature Name​ ​What It Does​
​New Document​ ​Create​ ​a​ ​new​ ​blank​ ​page​ ​for​

​typing​
​Font Formatting​ ​Change​ ​size,​ ​colour,​ ​bold,​ ​italic,​

​underline​
​Insert​ ​Add pictures, shapes, tables, etc.​
​Page Setup​ ​Set margin, page size, orientation​
​Spell Check​ ​Checks​ ​spelling​ ​and​ ​grammar​

​mistakes​
​Save & Open​ ​Save​ ​work​ ​or​ ​open​ ​saved​

​documents​
​Print​ ​Print the document on paper​
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​Component (Interface) of MS Word​
​Microsoft​ ​Word​ ​is​ ​a​ ​word​ ​processing​ ​software​ ​used​ ​to​ ​create,​ ​edit,​ ​and​
​format​​documents.​​It​​has​​many​​useful​​parts​​(components)​​that​​help​​users​
​work easily and efficiently.​

​1​​.​ ​Title​ ​Bar​ ​–​ ​Displays​ ​the​ ​name​ ​of​ ​the​ ​document​ ​in​ ​the​ ​MS​ ​Word​
​application.​

​5.​ ​Document Area​​– The main area where you type and​​edit your text.​
​6.​ ​Status​ ​Bar​ ​–​ ​Located​ ​at​ ​the​ ​bottom,​ ​it​ ​shows​ ​information​ ​such​ ​as​
​page number, word count, and language.​
​7.​ ​Scroll​ ​Bars​ ​–​ ​Used​ ​to​ ​move​ ​up,​ ​down,​ ​left,​ ​or​ ​right​ ​through​ ​the​
​document.​
​8.​ ​Cursor​ ​(Insertion​ ​Point)​ ​–​ ​A​ ​blinking​ ​vertical​ ​line​ ​that​ ​indicates​
​where text will appear when you type.​
​9.​ ​Ruler​​– Helps to align text, tables, and other​​elements on the page.​
​10.​​Zoom​​Control​​–​​Allows​​you​​to​​zoom​​in​​or​​zoom​​out​​of​​the​​document​
​for better visibility.​
​11.​ ​File​ ​Tab​ ​(Backstage​ ​View)​ ​–​ ​Contains​ ​options​ ​like​ ​New,​ ​Open,​
​Save, Print, and Share​
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​How to Open MS Word​

​Step 1​​.​ ​Click​​on the​​Start​​button (bottom-left corner).​
​Step 2.​ ​Type​​"Word" in the search bar.​
​Step 3​​.​ ​Click​​on "​​Microsoft Word​​" from the search​​results.​

​How to Create a new file in MS Word​

​Step 1​​.  If Word is already open, click on​​“File”​​in the top-left corner.​
​Step 2​​.  Click on​​“New”​​.​
​Step 3​​.  Select​​“Blank Document”​​.​
​Step 4​​.  A new Word file will open.​

​How to Add Text in MS Word​

​Step 1. Open MS Word.​
​Step 2. Click​​inside the white area (blank page).​
​Step 3. Start typing​​using your keyboard.​
​Step 4. Press Enter​​to go to the next line.​
​Step 5. Use Backspace​​to erase if you make a mistake.​

​How to Edit in MS Word​

​Editing​ ​in​ ​MS​ ​Word​ ​means​ ​changing​ ​or​ ​improving​ ​the​ ​text​ ​you​ ​have​
​already typed. You can add, remove, move, or correct your content.​

​Shiv Nadar Institution of Eminence​ ​22​​|​​Page​
​Deemed to be University​



​Steps:​
​Step 1​​.​​Open​​your MS Word document.​

​Step 2.​​Click​​on the text you want to change.​

​Step 3.​​Use​​Backspace​​or​​Delete​​to remove old text.​

​Step 4.​​Type​​new text to replace or add more.​

​Step 5.​​You can also​​select text​​using your mouse​​(drag over it) and then:​

​●​ ​Type to replace it​

​●​ ​Change font, size, colour from the​​Home​​tab​

​Editing Tools (in the Home tab):​

​●​ ​Cut​​– Ctrl + X (Removes the selected text.)​
​●​ ​Copy​​– Ctrl + C (Copies the selected text.)​
​●​ ​Paste​​– Ctrl + V (Inserts the cut/copied text at a​​new place.)​
​●​ ​Undo​​– Ctrl + Z (Reverses the last action.)​

​Formatting Text in MS Word​

​Formatting​ ​means​ ​changing​ ​the​ ​appearance​ ​of​ ​the​ ​text​ ​to​ ​make​ ​it​ ​look​
​better​ ​or​ ​to​ ​highlight​ ​important​ ​parts.​ ​This​ ​includes​ ​changing​ ​the​ ​font​
​style​​,​​size​​,​​colour​​,​​bold​​,​​italic​​,​​underline​​, etc.​

​Steps to Format Text in MS Word:​

​1.​ ​Open​​your document in MS Word.​
​2.​ ​Select the text​​you want to format​
​3.​ ​Go to the​​Home​​tab at the top.​
​4.​ ​Use different​​formatting tools​​in the​​Font group​
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​Common Formatting Tools and Their Definitions:​

​Tool​ ​Icon​ ​Definition / Use​

​Bold​ ​𝐁​ ​Makes​ ​text​ ​thicker​ ​and​ ​darker.​​Shortcut:​​Ctrl​

​+ B​

​Italic​ ​I​ ​Makes text slanted. Shortcut: Ctrl + I​

​Underline​ ​U​ ​Adds a line under the text. Shortcut: Ctrl + U​

​Font Style​ ​Aa​ ​Changes​ ​the​ ​look/design​ ​of​ ​the​ ​text​ ​(e.g.,​

​Arial, Times New Roman)​

​Font Size​ ​12, 14, 16…​ ​Increases or decreases the text size​

​Font Colour​ ​A​​🖍️​ ​Changes the colour of the text​

​Text​

​Highlight​

​🖍️​ ​Adds​ ​a​ ​background​ ​colour​ ​to​ ​text​ ​like​ ​a​

​highlighter​

​Text​

​Alignment​

​⬅️➡️​ ​Aligns the text to left, centre, right, or justify​

​Bullets & Numbering in MS Word​

​●​ ​Bullets​ ​are​ ​small​ ​symbols​ ​(like​ ​●​​,​ ​○​​,​ ​✔​​)​ ​used​ ​to​ ​make​ ​a​ ​list​ ​easier​ ​to​
​read.​

​●​ ​Numbering​​adds​​numbers​​(1,​​2,​​3...)​​or​​letters​​(a,​​b,​​c...)​​to​​list​​items​​in​
​order.​

​They are useful for​​organizing information​​clearly​
​Steps:​
​Step 1.​ ​Open​​your document in MS Word.​

​Step 2.​ ​Select the text​​you want to make into a list.​

​Step 3.​ ​Go to the​​Home​​tab.​

​Step 4.​ ​In the​​Paragraph group​​, click:​

​●​ ​Bullets (​​●​​)​​icon to make a bulleted list.​

​●​ ​Numbering (1, 2, 3)​​icon to make a numbered list.​

​Step 5.​​Choose the​​style/design​​you like.​
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​How to Insert: Table, Picture, Shapes in MS Word​

​Insert​ ​means​ ​to​ ​add​ ​something​ ​into​ ​your​ ​document,​ ​like​​a​​table,​​picture,​
​or shape, to make it more informative and attractive.​

​1. Insert a Table​

​A​ ​table​ ​is​ ​a​ ​grid​ ​made​ ​of​ ​rows​ ​and​ ​columns​ ​used​ ​to​ ​display​ ​data​ ​in​ ​a​
​structured way.​

​1. Steps to Insert a Table:​

​Step 1. Click on the Insert tab.​
​Step 2. Click Table.​
​Step 3. Choose how many rows and columns you need.​
​Step 4. Click to insert the table.​

​2. Insert  Picture​
​A​ ​picture​ ​is​ ​an​​image​​(from​​your​​computer​​or​​online)​​that​​you​​can​​add​​to​
​your document.​

​Steps to Insert a Picture:​

​Step 1.​​Click on the​​Insert​​tab.​
​Step 2.​​Click on​​Pictures​​.​
​Step 3.​​Choose​​This Device​​or​​Online Pictures​​.​
​Step 4.​​Select an image and click​​Insert​​.​

​3. Insert Shapes​

​Shapes​​are​​ready-made​​figures​​like​​rectangles,​​circles,​​arrows,​​etc.,​​used​​to​
​highlight or decorate content.​
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​Steps to Insert Shapes:​

​Step 1.​​Click on the​​Insert​​tab.​
​Step 2.​​Click on​​Shapes​​.​
​Step 3.​​Choose a shape (like circle, rectangle, arrow).​
​Step 4.​​Click and​​drag​​on the page to draw the shape.​

​Page Setup & Print in MS Word​

​●​ ​Page​ ​Setup​ ​means​ ​changing​ ​the​ ​layout​ ​of​ ​the​ ​page​ ​like​ ​margins,​
​orientation (portrait or landscape), and paper size.​

​●​ ​Print​​means taking a paper copy of your document using​​a printer.​

​1. Page Setup:​

​Steps to Set Up a Page:​
​Step 1.​​Click on the​​Layout​​tab (or​​Page Layout​​in​​older versions).​
​Step 2.​​Use the following options:​

​Tool​ ​Use​

​Margins​ ​Set​ ​the​ ​empty​ ​space​ ​around​ ​the​ ​page​ ​(top,​
​bottom, left, right).​

​Orientation​ ​Choose​ ​Portrait​ ​(vertical)​ ​or​ ​Landscape​
​(horizontal).​

​Size​ ​Choose paper size (like A4, Letter, etc.).​

​2. How to Print a Document​
​Steps to Print:​
​Step 1.​​Click on the File tab.​
​Step 2.​​Click on​​Print​​.​
​Step 3.​​Choose the​​printer​​.​
​Steps 4.​​Set​​number of copies​​,​​pages​​, and​​orientation​​.​
​Steps 5.​​Click on the​​Print​​button.​

​Activity:​
​Format a paragraph on “My Family” (bold, italic, colours, bullets)​
​Activity: Design a timetable using the Insert Table option.​
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​Unit 5 MS PowerPoint​

​INTRODUCTION OF MS POWER POINT:​

​●​ ​The​ ​program​ ​was​ ​created​ ​in​ ​a​ ​software​ ​company​ ​named​
​Forethought, Inc. by Robert Gaskins and Dennis Austin. ​

​●​ ​It​​was​​released​​on​​April​​20,​​1987,​​and​​after​​3​​months​​of​​its​​creation,​​it​
​was acquired by Microsoft.​

​●​ ​The​ ​first​ ​version​ ​of​​this​​program,​​when​​introduced​​by​​Microsoft,​​was​
​MS PowerPoint 2.0 (1990).​

​●​ ​It​​is​​a​​presentation-based​​program​​that​​uses​​graphics,​​videos,​​etc.​​to​
​make a presentation more interactive and interesting.​

​●​ ​The file extension of a saved PowerPoint presentation is “.ppt”.​
​●​ ​A​ ​PowerPoint​ ​presentation​ ​comprising​ ​slides​ ​and​ ​other​ ​features​ ​is​

​also known as PPT.​

​What is Microsoft PowerPoint?​

​PowerPoint​ ​(PPT)​ ​is​ ​a​ ​powerful,​ ​easy-to-use​ ​presentation​ ​graphics​
​software program​ ​that​​allows​​you​​to​​create​​professional-looking​​electronic​
​slide shows. ​
​The​ ​image​ ​given​ ​below​ ​shows​ ​the​ ​main​ ​page​ ​of​​MS​​PowerPoint,​​where​​a​
​person lands when the program is opened on a computer system:​
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​Why Do We Use PowerPoint?​

​Purpose​ ​Example​
​To give presentations​ ​Classroom​ ​teaching,​ ​project​

​display​
​To​ ​make​ ​learning​
​interesting​

​Using​ ​pictures,​ ​sound,​ ​and​
​animations​

​To​ ​explain​ ​topics​ ​step​ ​by​
​step​

​Showing​ ​slides​ ​one​ ​after​
​another​

​To​ ​present​ ​in​ ​front​ ​of​ ​an​
​audience​

​School events, competitions​

​Component (Interface) of Microsoft PowerPoint:​

​1. Slide​
​●​ ​Explanation: A single page in a PowerPoint presentation.​
​●​ ​Use:​ ​Each​ ​slide​ ​contains​ ​text,​ ​images,​ ​charts,​ ​or​ ​videos​ ​to​ ​present​

​ideas.​

​2. Slide Layout​
​●​ ​Explanation:​​Pre-designed​​templates​​for​​how​​content​​is​​arranged​​on​

​the slide.​
​●​ ​Types: Title Slide, Title and Content, Two Content, etc.​
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​●​ ​Use: Helps organize text, images, charts properly.​

​3. Placeholder​
​●​ ​Explanation:​ ​Dotted​ ​boxes​ ​on​ ​a​ ​slide​ ​where​ ​you​ ​can​ ​insert​ ​text,​

​pictures, charts, etc.​
​●​ ​Example: “Click to add title” is a placeholder.​

​4. Title Bar​
​●​ ​Explanation:​​Located​​at​​the​​top;​​shows​​the​​name​​of​​the​​presentation​

​file.​
​●​ ​Example: If the file name is Presentation1.pptx, it appears here.​

​5. Ribbon​
​●​ ​Explanation: Contains tabs and tools needed to design slides.​
​●​ ​Tabs​ ​Include:​ ​Home,​ ​Insert,​ ​Design,​ ​Transitions,​ ​Animations,​ ​Slide​

​Show, Review, View.​

​6. Slides Pane​
​●​ ​Explanation:​ ​On​ ​the​ ​left​ ​side​ ​of​ ​the​ ​window,​ ​shows​ ​a​ ​list​​of​​slides​​in​

​order.​
​●​ ​Use: You can rearrange, duplicate, or delete slides easily here.​

​7. Notes Pane​
​●​ ​Explanation:​ ​Below​ ​the​ ​slide,​ ​where​ ​the​ ​presenter​ ​can​ ​write​ ​notes​

​(not visible to the audience).​
​●​ ​Use: For reminders or explanations during the presentation.​

​8. Slide Area​
​●​ ​Explanation:​ ​Centre​ ​area​ ​where​ ​you​ ​design​ ​and​ ​edit​ ​the​ ​selected​

​slide.​
​9. Status Bar​
​●​ ​Explanation:​ ​At​ ​the​ ​bottom​ ​of​ ​the​ ​window.​ ​Shows​ ​slide​ ​number,​

​design view mode, zoom slider, etc.​

​10. Slide Show View​
​●​ ​Explanation: Runs the full-screen presentation.​
​●​ ​Shortcut: Press F5 to start the slide show from the beginning.​

​11. Design Themes​
​●​ ​Explanation:​​Predefined​​styles​​that​​apply​​colours,​​fonts,​​and​​effects​​to​

​all slides.​

​29​​|​​Page​
​Shiv Nadar Institution of Eminence​

​Deemed to be University​



​How to Open MS PowerPoint (Windows)​

​Using Start Menu​
​Step 1​​. Click on the Start Menu (Windows icon at the​​bottom-left corner).​
​Step 2.​​Type “PowerPoint” in the search bar.​
​Step 3.​​Click on “Microsoft PowerPoint” from the results​​.​

​How to Create a New PowerPoint File:​

​Step 1​​. Open MS PowerPoint.​
​Step 2​​. Click on “File” in the top left corner.​
​Step 3​​. Select “New” from the menu.​
​Step 4​​. Choose “Blank Presentation” (or select a template).​
​Step 5​​. A new presentation will open with one default​​slide​​.​

​How to Add Text:​
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​Step 1​​. Open your slide in PowerPoint.​
​Step 2​​. Click on the Text Box from the Insert tab.​
​Step 3​​. Click on the slide where you want the text.​
​Step 4​​. Type your text.​

​How to Create a New Slide​

​Step 1​​. Open your PowerPoint presentation.​
​Step 2​​. Go to the Home tab.​
​Step 3​​. Click on the New Slide button in the Slides​​group.​
​Step 4​​. A new slide will be added to your presentation.​
​Step​ ​5​​.​ ​You​ ​can​ ​choose​ ​a​ ​layout​ ​(like​ ​Title​ ​Slide,​ ​Title​ ​and​ ​Content,​ ​Two​

​Content, etc.)  by clicking the arrow under New Slide​​.​

​How to Add Images:​

​Step 1​​. Click on the Insert tab.​
​Step 2​​. Select Pictures → Choose This Device or Online​​Pictures.​
​Step 3​​. Select your image → Click Insert.​
​Step 4​​. Resize or move the image as needed.​
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​What is Transition?​

​A​​transition​​is​​the​​visual​​effect​​that​​happens​​when​​one​​slide​​changes​​to​​the​
​next​ ​during​ ​a​ ​presentation​ ​in​ ​MS​ ​PowerPoint.​ ​It​ ​helps​ ​make​ ​the​
​presentation look smooth and attractive.​

​How to Add Transitions (Between Slides)​

​Step 1​​. Click on the slide where you want to apply​​the transition.​
​Step 2​​. Go to the​​Transitions​​tab.​
​Step 3​​. Choose a transition effect like​​Fade​​,​​Push​​,​​or​​Wipe​​.​
​Step 4​​. You can also click​​“Effect Options”​​to customize​​the transition.​
​Step 5​​. Click​​Apply to All​​if you want the same transition​​on all slides.​

​What is Animation?​

​Animation​ ​in​ ​PowerPoint​ ​is​ ​a​ ​special​ ​effect​ ​used​ ​to​ ​make​ ​text,​ ​images,​
​shapes,​ ​or​ ​other​ ​objects​ ​move​ ​or​ ​appear​ ​in​ ​a​ ​creative​ ​way​ ​during​ ​a​
​slideshow.​

​How to Apply Animation​

​Step 1.​​Open your slide in PowerPoint.​
​Step 2.​​Click on the text or picture you want to animate.​
​Step 3.​​Go to the Animations tab at the top.​
​Step 4​​. Choose an animation like Fade, Fly In, Zoom,​​etc.​
​Step 5​​.  Done!  You have added animation.​
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​What is a Slide Show?​

​A​​Slide​​Show​​is​​the​​way​​to​​view​​your​​presentation​​on​​full​​screen​​—​​one​​slide​
​at a time — like a movie.​

​How to Start Slide Show:​

​Step 1. Click on the Slide Show tab.​
​Step 2. Then click on From Beginning to view all slides from the start.​
​Step 3. Or click From Current Slide to start from the selected slide.​
​Step​ ​4.​ ​Press​ ​F5​ ​on​ ​the​ ​keyboard​ ​to​ ​start​ ​the​ ​slide​ ​show​ ​from​ ​the​

​beginning.​
​Step 6. Use arrow keys to move forward or backward in the presentation.​
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​What is Page Setup?​

​Page​ ​Setup​ ​means​ ​changing​ ​the​ ​slide​ ​size​ ​or​ ​direction​ ​(portrait​ ​or​
​landscape) before printing or presenting.​

​How to Do Page Setup:​

​Step 1.​​Open PowerPoint.​
​Step 2​​. Click on the​​“Design”​​tab.​
​Step 3​​. Click on​​“Slide Size”​​.​
​Step 4​​. Choose:​

​●​ ​Standard (4:3)​​or​
​●​ ​Widescreen (16:9)​
​1.​ ​Or click​​“Custom Slide Size”​​to choose your own.​
​2.​ ​You can set slide​​Orientation​​:​
​●​ ​Landscape​​(sideways) or​
​●​ ​Portrait​​(up and down)​

​Step 5.​​Click​​OK​​to apply.​

​Activity:​
​Create​​a​​4-slide​​presentation​​on​​"My​​School"​​or​​"My​​Family​​“and​​use​​all​​the​

​tools.​
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​Unit 6 MS Excel​

​What is MS Excel?​

​MS​​Excel​​is​​a​​spreadsheet​​program​​where​​you​​can​​record​​data​​in​​the​​form​
​of tables. It is easy to analyse data in an Excel spreadsheet.​

​●​ ​An MS Excel file is saved with an extension of .xls​

​●​ ​Companies​ ​with​ ​large​ ​staff​ ​and​ ​workers​ ​use​ ​MS​ ​Excel​ ​as​ ​saving​

​employee information becomes easier​

​●​ ​Excel​ ​spreadsheets​ ​are​ ​also​​used​​in​​hospitals​​where​​the​​information​

​of​ ​patients​ ​can​ ​be​ ​saved​ ​more​ ​easily​ ​and​ ​can​ ​be​ ​removed​

​conveniently once their medical history is cleared​

​●​ ​The sheet on which you work is called a Worksheet​

​●​ ​Multiple worksheets can be added in a single Excel file​

​●​ ​This is a data processing application​

​The image given below represents how an Excel spreadsheet looks like:​
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​Component (Interface) of MS Excel​

​What is a Spreadsheet?​

​A​ ​Spreadsheet​​is​​a​​digital​​sheet​​made​​up​​of​​rows​​and​​columns​​that​​helps​
​users to enter, edit, calculate, and analyse data easily.​

​Basic Terms in MS Excel:​

​Term​ ​Meaning​

​Workbook​ ​The entire Excel file​

​Worksheet​ ​A single sheet/page within a workbook​

​Row​ ​Horizontal line in the sheet (numbered 1, 2, 3, ...)​

​Column​ ​Vertical line in the sheet (labelled A, B, C, ...)​

​Cell​ ​Intersection of a row and a column (e.g., A1, B2)​
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​What is cell?​

​A​​cell​​is​​the​​smallest​​unit​​or​​box​​in​​a​​Microsoft​​Excel​​worksheet.​​It​​is​​where​
​you​ ​can​ ​enter,​ ​store,​ ​and​ ​manage​ ​data​ ​like​ ​numbers,​ ​text,​ ​dates,​ ​or​
​formulas​​.​

​What is Cell Address?​

​The​ ​cell​ ​address​ ​is​ ​the​ ​name​ ​by​ ​which​ ​the​ ​cell​ ​can​ ​be​ ​addressed.​ ​For​
​example, if row 7 is interested in column G, then the cell address is G7. ​

​How to Open MS Excel​

​From Start Menu​

​Step 1.​​Click on the​​Start​​button (bottom-left corner).​
​Step 2.​​Type​​Excel​​in the search box.​
​Step 3.​​Click on​​Microsoft Excel​​from the list.​
​Step 4.​​Excel will open​​on your screen.​

​How to Create file in MS Excel​

​Step 1. Open MS Excel.​
​Step 2.​​Click on​​File​​in the top-left corner.​
​Step 3.​​Click on​​New​​from the menu.​
​Step 4.​​Choose​​Blank Workbook​​.​
​Step 5.​​A new file will open — you can now enter your data.​
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​Entering and Editing Data in MS Excel​

​What is Data in Excel?​

​In​ ​Excel,​ ​data​ ​means​ ​any​ ​information​ ​you​ ​type​​into​​a​​cell​​—​​like​​numbers,​
​text, or formulas.​

​How to Enter Data in a Cell:​

​Step 1.​​Click on a cell where you want to enter data​​(e.g., A1).​
​Step 2.​​Type the data (text, number, or date).​
​Step 3.​​Press Enter or Tab to move to the next cell.​

​How to Edit Data in a Cell:​

​If you made a mistake or want to change the data than follow the Steps:​
​Method 1: Double-click to Edit​

​Step 1.​​Double-click on the cell.​
​Step 2.​​Change the text or number.​
​Step 3.​​Press Enter to save.​

​Method 2: Use Formula Bar​

​Step 1.​​Click on the cell.​
​Step 2.​​Go to the Formula Bar (top of the sheet).​
​Step 3.​​Edit the data.​
​Step 4.​​Press Enter.​
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​Basic Formulas in MS Excel​

​What is a Formula?​

​A​ ​formula​ ​in​ ​Excel​ ​is​ ​a​ ​mathematical​ ​expression​ ​used​ ​to​ ​perform​
​calculations.​
​Every formula in Excel starts with an equal sign =.​

​Common Basic Formulas:​

​Operation​ ​Formula​
​Synta​
​x​

​Example​ ​Result​

​Addition​ ​=A1 + B1​ ​=10 + 20​ ​30​

​Subtraction​ ​=A1 - B1​ ​=50 – 30​ ​20​

​Multiplication​ ​=A1 * B1​ ​=5 * 4​ ​20​

​Division​ ​=A1 / B1​ ​=40 / 5​ ​8​

​Combine​ ​Numbers​
​and Cells​

​=A1 + 10​ ​If​ ​A1​ ​=​ ​20,​ ​then​
​=A1+10​

​30​

​How to Use Formulas in Excel​

​Steps:​

​Step 1.​​Open Excel​
​Step2​​. Type numbers in two cells​

​Example:​​10 in A1, 20 in B1​

​Step 3​​. Click on another cell (like C1) for result​
​Step 4.​​Type the formula in cell or in the formula​​bar​

​Example: =A1 + B1​
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​Step 5.​​Press Enter​

​Excel shows the answer: 30​

​Note​​: Formula Is Always Start with” =” equal sign.​​(e.g: =A1+A2)​

​What is a Function in MS Excel?​

​A​ ​Function​ ​in​ ​MS​ ​Excel​ ​is​ ​a​ ​pre-written​ ​formula​ ​that​ ​helps​ ​you​ ​do​ ​quick​
​calculations like total, average, maximum, minimum, etc.​

​Important Points:​

​●​ ​Every function starts with = sign​
​●​ ​Then comes the function name, like SUM, AVERAGE, etc.​
​●​ ​After that, you write the cell range in brackets ().​
​●​ ​=FUNCTION_NAME (cell range)​

​Basic Functions in MS Excel:​

​Function​
​Name​

​Use​ ​Example​ ​Result​ ​(if​​A1​​to​​A5​
​=​ ​10,​ ​20,​ ​30,​
​40, 50)​

​SUM ()​ ​Adds numbers​ ​=SUM (A1:A5)​ ​150​

​AVERAGE ()​ ​Finds average​ ​=AVERAGE​
​(A1:A5)​

​30​

​MAX ()​ ​Finds​ ​largest​
​number​

​=MAX (A1:A5)​ ​50​

​MIN ()​ ​Finds​ ​smallest​
​number​

​=MIN (A1:A5)​ ​10​

​COUNT ()​ ​Counts​ ​how​ ​many​
​cells have data​

​=COUNT​
​(A1:A5)​

​5​
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​How to Use a Function in Excel​

​Steps:​

​Step​​1. Open Excel​

​Step 2.​​Type numbers in some cells​

​Example: A1 = 10, A2 = 20, A3 = 30​

​Step 3.​​Click on an empty cell (like A4)​

​Step 4.​​Type a function​

​Example: =SUM (A1:A3)​

​Step 5​​. Press Enter​

​Excel will show the answer: 60​

​What is AutoSum in MS Excel?​

​AutoSum​ ​is​ ​a​ ​button​ ​in​ ​Excel​ ​that​ ​quickly​ ​adds​ ​up​ ​numbers​ ​in​ ​a​ ​row​ ​or​
​column​ ​using​ ​the​ ​SUM​ ​function​ ​automatically.​ ​It​ ​is​ ​mostly​ ​used​ ​for​ ​sum​
​but. you can use all the functions in Autosome like. (Average, count etc).​
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​How to Use AutoSum (Step-by-step):​

​Step 1.​​Type numbers in cells (e.g., A1 to A3).​
​Step 2.​​Click on the next empty cell (e.g., A4).​
​Step 3.​​Go to the Home tab on the top​​.​
​Step 4.​​Click on the AutoSum (∑) button and Select​​the Function​​.​
​Step 5.​​Press Enter and Give the range in brackets.​

​Activity:​
​Enter a list of student names, classes, and marks and use formulas in Excel​
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​Unit 7 Introduction of Internet​

​What is the Internet?​

​The​ ​Internet​ ​is​ ​a​ ​global​ ​network​ ​that​ ​connects​ ​millions​​of​​computers​​and​
​devices​ ​worldwide.​ ​It​ ​allows​ ​people​ ​to​ ​share​ ​information,​ ​communicate,​
​watch​ ​videos,​ ​play​ ​games,​ ​shop,​ ​and​ ​much​ ​more.​ ​It​ ​works​ ​through​ ​a​
​system​ ​of​ ​servers​ ​and​ ​networks​ ​that​ ​transfer​ ​data​ ​from​ ​one​ ​place​ ​to​
​another using web addresses (URLs).​

​Importance of Internet in Daily Life​

​The Internet is very important in our day-to-day life. Here’s how:​

​●​ ​📚​ ​Education​​:​ ​Helps​ ​students​ ​attend​ ​online​ ​classes,​ ​do​ ​research,​
​and access e-books.​

​●​ ​📧​ ​Communication​​:​ ​We​ ​can​ ​send​ ​emails,​ ​make​ ​video​ ​calls,​ ​and​
​chat with anyone around the world.​

​●​ ​🛍️​ ​Shopping​​:​ ​Online​ ​shopping​ ​websites​ ​help​ ​us​ ​buy​ ​things​​from​
​home.​
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​●​ ​📰​ ​News​​and​​Information​​:​​We​​can​​read​​news​​and​​get​​the​​latest​
​updates easily.​

​●​ ​🎮​ ​Entertainment​​:​ ​Watch​ ​movies,​ ​listen​ ​to​ ​songs,​ ​or​ ​play​ ​online​
​games​

​●​ ​💼​ ​Jobs​ ​and​ ​Work​​:​ ​Many​ ​people​ ​work​ ​from​ ​home​ ​using​ ​the​
​Internet.​

​●​ ​💳​ ​Banking​​and​​Payments​​:​​Online​​banking​​and​​UPI​​apps​​help​
​us transfer money​

​What is a Browser?​

​A​ ​Web​ ​Browser​ ​is​ ​a​ ​software​ ​application​ ​that​ ​we​ ​use​ ​to​ ​access​ ​and​​view​
​websites on the Internet.​

​Examples:​​Google Chrome, Mozilla Firefox, Microsoft​​Edge, Safari​
​When​​you​​type​​a​​website​​address​​(like​​www.google.com)​​into​​a​​browser,​​it​
​opens that website​​.​

​What is a Search Engine?​

​A Search Engine is a tool used to find information on the Internet.​
​Examples​​:​​Google, Bing, Yahoo, DuckDuckGo​
​You​ ​type​ ​keywords​​or​​questions,​​and​​the​​search​​engine​​shows​​you​​related​
​websites and answers​
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​Introduction of Google office​

​Google​ ​Office,​ ​now​ ​called​ ​Google​ ​Workspace,​ ​is​ ​a​ ​collection​ ​of​ ​online​
​applications​ ​created​ ​by​ ​Google.​ ​These​ ​applications​ ​include​ ​Google​ ​Docs,​
​Google​​Sheets,​​Google​​Slides,​​Google​​Drive.​​Unlike​​traditional​​software,​​you​
​do​ ​not​ ​need​ ​to​ ​install​ ​them​ ​on​ ​your​ ​computer.​ ​They​ ​work​ ​directly​ ​on​​the​
​internet.​

​Key Points:​

​●​ ​Online Tools​

​Google​​Docs,​​Sheets,​​Slides,​​etc.,​​are​​called​​online​​tools​​because​​they​
​work​ ​on​ ​the​ ​internet.​ ​You​ ​don’t​ ​need​ ​to​ ​install​ ​them​ ​on​ ​your​
​computer.​​Just​​log​​in​​to​​your​​Google​​account,​​and​​you​​can​​use​​them​
​from any device.​

​●​ ​Cloud Storage​

​This​​means​​your​​files​​are​​not​​saved​​only​​on​​your​​computer​​but​​on​​the​
​internet,​​in​​a​​place​​called​​Google​​Drive​​.​​Because​​of​​this,​​your​​files​​are​
​safe,​ ​and​ ​you​ ​can​ ​open​ ​them​ ​anytime,​ ​anywhere.​ ​Even​ ​if​ ​your​
​computer is lost or damaged, your work is not lost.​

​●​ ​Real-time Collaboration​

​A​​special​​feature​​of​​Google​​Workspace​​where​​many​​people​​can​​work​
​on​ ​the​ ​same​ ​file​ ​at​ ​the​ ​same​ ​time.​ ​For​ ​example,​ ​four​ ​students​ ​can​
​type​ ​in​ ​one​ ​Google​ ​Doc​ ​together,​ ​even​ ​if​ ​they​ ​are​ ​at​ ​their​ ​own​
​homes. They can also see each other’s changes instantly.​

​●​ ​Auto Save​

​Everything​ ​you​ ​type​ ​or​ ​edit​ ​is​ ​saved​ ​automatically​ ​in​ ​Google​ ​Drive.​
​You​ ​don’t​ ​need​ ​to​ ​press​ ​the​ ​“Save”​ ​button​ ​again​ ​and​ ​again.​ ​Even​ ​if​
​the internet disconnects suddenly, your work is safe.​

​●​ ​Accessibility​

​Accessibility​ ​means​ ​you​ ​can​ ​open​ ​your​ ​files​ ​from​ ​anywhere​ ​and​ ​on​ ​any​
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​device.​ ​Students​ ​can​ ​open​ ​their​ ​homework​ ​on​ ​a​ ​school​ ​computer,​ ​check​
​notes on their phone at home, or edit a project on a tablet while traveling.​
​Google Tools:​

​Google Docs (Writing Tool)​

​●​ ​Similar to​​Microsoft Word​​but works online.​
​●​ ​Used for​​essays, reports, assignments, and notes​​.​

​Features:​

​●​ ​Auto-save (saves automatically).​
​●​ ​Insert images, tables, and charts.​
​●​ ​Formatting options (bold, underline, font, colour).​
​●​ ​Real-time collaboration (many can edit together).​

​Examples for students:​

​●​ ​English essay writing.​
​●​ ​Science project report.​
​●​ ​History notes.​
​●​ ​Homework typing.​

​Google Sheets (For Data & Numbers)​

​●​ ​Similar to​​Microsoft Excel​​.​
​●​ ​Used for​​calculations and data management​​.​

​Features:​

​●​ ​Rows and columns (data in cells).​
​●​ ​Perform calculations (addition, subtraction, average).​
​●​ ​Create tables, graphs, and charts.​
​●​ ​Real-time editing with classmates​

​Examples for students:​

​●​ ​Science experiment data.​
​●​ ​Class attendance register.​
​●​ ​Marks calculation sheet.​
​●​ ​Budget for school events.​
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​Google Slides (For Presentations)​

​Similar to​​Microsoft PowerPoint​​.​
​Used to​​make presentations in slides​​.​

​Features:​

​●​ ​Add text, images, video, and animation.​
​●​ ​Ready-made themes and layouts.​
​●​ ​Transition effects between slides.​
​●​ ​Many students can add slides together.​

​Examples for students:​

​●​ ​History project presentation.​
​●​ ​Science fair project.​
​●​ ​Seminar or class project.​
​●​ ​Explaining topics like “Solar System.”​

​Google Drive​

​Google​ ​Drive​ ​is​ ​an​ ​online​ ​storage​ ​platform​ ​provided​ ​by​ ​Google.​ ​It​ ​allows​
​users​​to​​save​​documents,​​images,​​videos,​​and​​all​​kinds​​of​​files​​safely​​on​​the​
​internet instead of only keeping them on their computer.​

​Features:​

​●​ ​Saves all Google Docs, Sheets, Slides, and Forms automatically.​
​●​ ​Files are safe even if your computer or phone gets damaged.​
​●​ ​Can create folders to organize homework, notes, and projects.​
​●​ ​Easy to​​share​​files with teachers or classmates by​​sending a link.​
​●​ ​Access​ ​your​ ​files​ ​from​ ​any​ ​device​ ​(computer,​ ​laptop,​ ​tablet,​ ​or​

​mobile).​
​●​ ​Supports uploading of large files like videos and pictures.​

​Examples for Students​

​●​ ​Storing homework assignments and essays.​
​●​ ​Keeping science project reports and charts.​
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​●​ ​Uploading class notes to revise later.​
​●​ ​Sharing a folder of study material with classmates.​
​●​ ​Submitting work to teachers without using a pen drive.​

​Activity​​:​
​Use the Google Office​
​Activity:​
​Use​ ​Google​ ​to​ ​find​ ​facts​ ​on​ ​your​ ​idol​ ​and​ ​any​ ​famous​ ​person​ ​&​ ​Write​ ​In​

​Notebook​
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​What are Cloud Services​

​●​ ​Google​ ​Cloud​ ​Services​ ​are​ ​online​ ​tools​ ​provided​ ​by​ ​Google​ ​that​
​help​ ​individuals,​ ​schools,​ ​and​ ​businesses​ ​store,​ ​manage,​ ​and​ ​use​
​data safely on the internet​​.​

​●​ ​Instead​ ​of​ ​keeping​ ​everything​ ​only​ ​on​ ​a​ ​computer​ ​or​ ​hard​ ​disk,​ ​we​
​can​ ​save​ ​our​ ​files,​ ​documents,​ ​photos,​ ​and​ ​applications​​on​​Google’s​
​cloud.​

​●​ ​This​​makes​​it​​possible​​to​​access​​files​​anywhere,​​anytime,​​from​​any​
​device​​(computer, tablet, or mobile phone).​

​●​ ​Google​ ​Cloud​ ​Services​ ​also​​provide​​many​​applications​​for​​working,​
​learning, and sharing​​.​

​Benefits of Cloud Services:​

​●​ ​Accessibility​ ​–​ ​Files​ ​can​ ​be​ ​opened​ ​anytime​ ​with​ ​internet​
​connection.​

​●​ ​Collaboration​ ​–​ ​Many​ ​people​ ​can​ ​work​ ​together​​on​​the​​same​​file​​at​
​the same time.​

​●​ ​Data Safety​​– Data is protected with Google’s strong​​security system.​
​●​ ​Cost​​Saving​​–​​No​​need​​to​​buy​​extra​​storage​​devices​​like​​pen​​drives​​or​

​external hard disks.​
​●​ ​Automatic Updates​​– Apps and services get updated​​automatically.​
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​●​ ​Backup​ ​Facility​ ​–​ ​If​ ​a​ ​device​ ​is​ ​lost​ ​or​ ​damaged,​ ​data​ ​is​ ​still​ ​safe​
​online.​

​●​ ​Environment​ ​Friendly​ ​–​ ​Reduces​ ​the​ ​need​ ​for​​physical​​storage​​and​
​paper.​

​Importance of Cloud Services:​

​●​ ​For​ ​Students​ ​and​ ​Teachers​ ​–​ ​Helps​ ​in​ ​sharing​ ​homework,​ ​notes,​
​assignments,​ ​and​ ​presentations.​ ​Online​ ​classes​ ​and​ ​group​ ​projects​
​become easier.​

​●​ ​For​ ​Business​ ​–​ ​Companies​ ​use​ ​it​ ​for​ ​storing​ ​data,​ ​running​ ​software,​
​and working with teams across the world.​

​●​ ​For​​Daily​​Life​​–​​People​​use​​Google​​Drive,​​Gmail,​​and​​Google​​Photos​​to​
​keep documents and memories safe.​

​●​ ​For​ ​Innovation​ ​–​ ​Developers​ ​use​ ​Google​ ​Cloud​ ​to​ ​build​ ​apps,​
​websites, and smart technologies.​

​●​ ​For​ ​Remote​ ​Work​ ​–​ ​In​ ​today’s​​world,​​cloud​​services​​make​​it​​possible​
​to work from home or any location.​

​Importance​ ​Simple Explanation​

​Saves Money​ ​No​ ​need​ ​to​ ​buy​ ​big​​computers​​or​​storage.​​Use​
​online services instead.​

​Can​ ​be​ ​Used​ ​Anytime,​
​anywhere​

​You​​can​​use​​it​​from​​school,​​home,​​or​​even​​while​
​travelling.​

​Safe Storage​ ​Your​ ​photos,​ ​videos,​ ​or​ ​homework​ ​are​ ​safely​
​saved in the cloud.​

​No​ ​Worry​ ​About​
​Losing Files​

​Even​ ​if​ ​your​ ​phone​ ​or​ ​computer​ ​breaks,​ ​your​
​files stay safe in the cloud.​

​Easy Sharing​ ​You​ ​can​ ​share​ ​notes​ ​or​ ​projects​ ​with​ ​friends​
​and teachers easily.​

​Works on Any Device​ ​Can be used on mobile, tablet, or computer.​
​No Need for Updates​ ​Software​​is​​always​​up​​to​​date.​​No​​need​​to​​install​

​anything.​
​Helps in Learning​ ​Use​ ​Google​ ​Classroom,​ ​YouTube,​ ​and​ ​other​

​apps for studying online.​

​Examples of Cloud Services:​
​●​ ​Google Drive​
​●​ ​OneDrive​
​●​ ​iCloud​
​Activity:​​Create a Folder in Google Drive and save​​files​
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​What is Artificial Intelligence (AI)​

​Artificial​ ​Intelligence​ ​(AI)​ ​is​ ​the​ ​ability​ ​of​ ​a​ ​computer​ ​or​ ​machine​ ​to​ ​think​
​and​ ​learn​ ​like​ ​humans.​ ​It​ ​uses​ ​special​ ​programs​ ​and​ ​data​ ​to​ ​solve​
​problems,​ ​understand​ ​speech,​ ​make​ ​decisions,​ ​and​ ​even​ ​recognize​
​pictures or faces.​

​In simple words:​

​AI​​means​​"smart​​machines"​​that​​can​​do​​tasks​​on​​their​​own​​like​​humans​​—​
​such as talking, playing games, solving math problems, or driving cars.​

​Examples of AI in Daily Life:​

​●​ ​Voice assistants like Alexa, Siri, or Google Assistant​
​●​ ​Face unlocks in mobile phones​
​●​ ​Chatbots on websites​
​●​ ​Self-driving cars​
​●​ ​Google Translate​

​Importance of Artificial Intelligence​

​AI is becoming very important in today’s world because:​

​1.​ ​Helps in Education​
​●​ ​AI​ ​tutorials​ ​and​ ​learning​ ​apps​ ​help​ ​students​ ​understand​ ​topics​

​better.​

​2.​ ​Healthcare​
​●​ ​AI helps doctors detect diseases and suggest treatments faster.​

​3.​ ​Agriculture​
​●​ ​AI is used to predict weather, monitor crops, and improve farming.​

​4.​ ​Daily Life​
​●​ ​Smart devices, maps, and apps use AI to make life easier.​

​5.​ ​Safety and Security​
​●​ ​AI helps in face detection, CCTV analysis, and cyber protection.​
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​6.​ ​Job Assistance​
​●​ ​AI​ ​tools​ ​help​ ​people​ ​write​ ​resumes,​ ​search​ ​jobs,​ ​and​ ​even​ ​give​

​interview tips.​

​Topic​ ​Details​

​AI​ ​(Artificial​
​Intelligence)​

​Smart​ ​technology​ ​that​ ​helps​ ​machines​ ​work​
​like humans​

​Used in​ ​Mobiles,​ ​apps,​ ​cars,​ ​hospitals,​ ​education,​
​farming, etc​

​Benefit of AI​

​No​ ​Benefit​ ​Explanation​
​1​ ​Saves Time​ ​AI works fast and doesn’t take breaks.​

​2​ ​Smart Suggestions​ ​Helps​ ​you​ ​find​ ​videos,​ ​books,​ ​or​ ​songs​ ​you​
​like.​

​3​ ​Helps in Studies​ ​Solves​ ​problems,​ ​explains​ ​topics,​ ​and​
​teaches languages.​

​4​ ​Safety​ ​AI​ ​can​ ​detect​ ​fraud,​ ​alert​ ​in​ ​emergencies,​
​and guide drivers.​

​5​ ​Helps​ ​Disabled​
​People​

​AI​ ​reads​ ​for​ ​blind​ ​people​ ​or​ ​types​ ​when​
​someone speaks.​
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​Current AI Applications​

​1. ChatGPT (Conversational AI)​

​Definition​

​ChatGPT​ ​is​ ​an​ ​AI​ ​chatbot​ ​that​ ​can​ ​hold​ ​conversations,​ ​answer​
​questions, write stories or poems, and help with homework ideas​

​Features​

​●​ ​Understands and responds in human-like writing​
​●​ ​Helps with essays, ideas, and even coding​
​●​ ​Available on web and mobile apps (both free and paid versions)​

​Examples for Students​

​●​ ​Ask for help writing an essay or story​
​●​ ​Get explanations for math or science questions​
​●​ ​Learn coding basics through simple examples​

​2. Google Gemini (Multimodal AI​

​Definition​

​Gemini​ ​is​ ​Google’s​ ​AI​ ​that​ ​can​ ​understand​ ​and​ ​respond​ ​using​ ​both​ ​text​
​and images—called “multimodal.”​

​Features​

​●​ ​Handles text, images, and spoken commands​
​●​ ​Shows natural conversation + visuals​

​Examples for Students​

​●​ ​Ask Gemini to explain a science diagram​
​●​ ​Get image-based help with project ideas​
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​3. Grammarly AI Agents (Writing Helper)​

​Definition​

​Grammarly’s​ ​newest​ ​AI​ ​tools​ ​help​ ​students​ ​write​ ​better​ ​by​ ​checking​
​grammar, making suggestions, and even predicting grades.​

​Features​

​●​ ​Proofreader, paraphraser, citation finder​
​●​ ​Predicts how readers might react and predicts potential grades​

​Examples for Students​

​●​ ​Polish an essay before submission​
​●​ ​Check plagiarism or improve readability​

​Activity:​
​Write​ ​application​ ​for​ ​holiday​ ​by​ ​current​ ​application​ ​(ChatGPT​ ​(general​

​prompt and vernacular))​
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​Unit 8 Cyber Safety and Safe Online Behaviour​

​What is Cyber Safety​

​Cyber​ ​Safety​ ​means​ ​staying​ ​safe​ ​while​ ​using​ ​the​ ​Internet.​ ​It​ ​includes​
​protecting​ ​your​ ​personal​ ​information,​ ​using​ ​strong​ ​passwords,​ ​avoiding​
​dangerous websites, and being careful with strangers online.​
​It​​helps​​you​​stay​​protected​​from​​online​​threats​​like​​hackers,​​viruses,​​scams,​
​and cyberbullying​​.​

​Dos and Don’ts While Using the Internet​

​✅​​Dos​ ​❌​​Don’ts​

​Use​ ​strong​ ​and​ ​unique​
​passwords​

​Don’t share your passwords with anyone​

​Visit only trusted websites​ ​Don’t open unknown links or emails​

​Log​ ​out​ ​from​ ​public​
​computers​

​Don’t​​post​​personal​​details​​(like​​address​​or​
​phone number) online​

​Report any online bullying​ ​Don’t talk to strangers on the Internet​

​Keep your software updated​ ​Don’t download files from unsafe sites​

​Cyber Safety Rules for Students​

​1.​ ​Never​ ​share​ ​personal​ ​information​ ​(name,​ ​address,​ ​phone​ ​number)​
​online.​

​2.​ ​Always use strong passwords and change them regularly.​
​3.​ ​Avoid chatting with strangers on the Internet.​
​4.​ ​Inform your parents or teacher if something feels unsafe online.​
​5.​ ​Don’t open emails or messages from unknown people.​
​6.​ ​Use privacy settings on social media apps.​
​7.​ ​Think before you click any link, download, or share anything.​
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​Password Protection​

​Passwords keep your online accounts safe and private.​

​Good password habits:​

​●​ ​Use a mix of letters, numbers, and symbols​
​●​ ​Don’t use easy words like 123456 or your name​
​●​ ​Never share your password with anyone​
​●​ ​Change passwords regularly​

​Example of a strong password:​

​Saurabh@1234​

​What is Personal Information?​

​Personal​ ​Information​ ​means​ ​the​ ​private​ ​details​​about​​you​​that​​others​​can​
​use to identify or contact you.​

​Examples of Personal Information:​

​Information Type​ ​Example​
​Full Name​ ​Rohan Sharma​
​Home Address​ ​123, MG Road, Delhi​
​Phone Number​ ​9876543210​
​Email ID​ ​rohan@gmail.com​
​Date of Birth​ ​10 January 2011​
​School Name & Class​ ​ABC​ ​Public​ ​School,​ ​Class​

​8​
​Passwords​ ​(Should​ ​always​ ​be​ ​kept​

​secret)​
​Photographs or Videos​ ​Selfies,personal pictures​
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​Why Should You Protect Your Personal Info?​

​Reason​ ​Explanation​

​🚫​​To avoid cyberbullying​ ​Someone​ ​may​ ​use​ ​your​ ​info​ ​to​ ​trouble​
​you online.​

​💻​ ​To​ ​stay​ ​safe​ ​on​ ​the​
​internet​

​Hackers can misuse your data.​

​🔐​ ​To​ ​prevent​ ​identity​
​theft​

​Others might pretend to be you.​

​🤫​ ​To​ ​keep​ ​your​ ​life​
​private​

​Not​ ​everyone​ ​needs​ ​to​ ​know​ ​your​
​personal details.​

​How to Protect Your Personal Information​

​🔐​​Tip​ ​What to Do​
​Use strong passwords​ ​Mix​​letters,​​numbers​​&​​symbols.​​Don’t​​share​

​passwords.​
​Don't share details online​ ​Never​ ​post​ ​your​ ​phone​ ​number​ ​or​ ​address​

​on social media.​
​Ask​ ​parents​ ​before​ ​sharing​
​info​

​Always take permission.​

​Be​ ​careful​ ​while​ ​filling​
​forms​

​Only enter info on trusted websites.​

​Don't​ ​talk​ ​to​ ​strangers​
​online​

​Block or report unknown people.​

​Keep accounts private​ ​Use​​privacy​​settings​​on​​apps​​like​​Instagram​
​or Facebook.​

​Log​ ​out​ ​after​ ​using​ ​public​
​computers​

​Always sign out of accounts.​

​Activity:​
​Assessment on Cyber Safety​
​Activity​​:​
​Give the Situations (Dos & Don’t)​
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​Social Media​

​What is Social Media?​

​●​ ​Social​​media​​refers​​to​​websites​​and​​applications​​that​​allow​​people​​to​
​communicate,​ ​create,​ ​and​ ​share​ ​content​ ​such​ ​as​ ​information,​
​photos, videos, and messages with others.​

​●​ ​It​​is​​like​​a​​virtual​​world​​where​​people​​can​​connect​​with​​family,​​friends,​
​classmates, and even strangers from different parts of the world​

​●​ ​Social​ ​media​ ​has​ ​become​ ​a​ ​part​ ​of​ ​our​ ​daily​​lives.​​From​​morning​​to​
​night,​ ​many​ ​people​ ​check​ ​their​ ​social​ ​media​ ​accounts​ ​for​ ​news,​
​updates, and entertainment.​

​Examples:​

​●​ ​Facebook – For social networking.​
​●​ ​Instagram – For sharing pictures and short videos.​
​●​ ​WhatsApp – For instant chatting.​
​●​ ​YouTube – For learning and entertainment.​
​●​ ​LinkedIn – For career and professional growth.​

​Key​​Point:​​Social​​media​​is​​not​​only​​about​​fun​​and​​entertainment,​​but​​also​
​about knowledge, awareness, and global connection.​

​Types of Social Media​

​Social media can be divided into different types based on their use.​

​1. Social Networking Sites​

​●​ ​Platforms like Facebook, Instagram, Twitter (X).​
​●​ ​Used​ ​for​ ​sharing​ ​thoughts,​ ​pictures,​ ​daily​ ​life​ ​updates,​ ​and​

​connecting with friends.​

​2. Messaging Applications​

​●​ ​Apps like WhatsApp, Telegram, Messenger.​
​●​ ​Used for private and group chats, sending files, and video calls.​
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​3. Video Sharing Platforms​

​●​ ​YouTube, TikTok, Instagram Reels.​
​●​ ​People​ ​upload​ ​videos​ ​for​ ​education,​ ​entertainment,​ ​cooking,​

​gaming, news, and vlogging.​

​4. Professional Networks​

​●​ ​LinkedIn is the best example.​
​●​ ​Students​ ​and​ ​professionals​ ​use​ ​it​ ​for​ ​jobs,​ ​internships,​ ​networking,​

​and business.​

​5. Educational Platforms​

​●​ ​Quora, Brainly, Coursera, Edmodo, YouTube educational channels.​
​●​ ​These help students learn new things.​

​3. Importance of Social Media​

​Social media plays a big role in modern life. It has many benefits:​

​1.​ ​Communication – Talk to anyone, anytime, anywhere.​
​2.​ ​Information – Get news and updates instantly.​
​3.​ ​Education – Online tutorials, lectures, and e-learning.​
​4.​ ​Awareness – Social issues, health tips, government schemes.​
​5.​ ​Entertainment – Music, movies, comedy, games.​
​6.​ ​Creativity – Share artwork, videos, dance, music.​
​7.​ ​Business and Marketing – Companies advertise their products.​
​8.​ ​Global Connection – Learn about different cultures and countries.​

​Real-life​ ​Example:​ ​During​ ​the​ ​COVID-19​​lockdown,​​social​​media​​was​​used​
​for online classes, spreading health awareness, and connecting families​
​.​
​4. Use of Social Media for Students​

​Social media can be very useful for students if used carefully:​
​1.​ ​Learning​ ​and​ ​Research​ ​–​ ​Students​ ​can​ ​watch​ ​online​ ​lectures,​ ​find​

​notes, and prepare for exams.​
​2.​ ​Group​ ​Studies​ ​–​ ​WhatsApp​ ​or​ ​Telegram​ ​groups​ ​for​ ​discussing​

​homework and projects.​
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​3.​ ​Skill​​Development​​–​​YouTube​​tutorials​​for​​drawing,​​coding,​​speaking,​
​etc.​

​4.​ ​Communication – Stay connected with classmates and teachers.​
​5.​ ​Career​ ​Opportunities​ ​–​ ​Platforms​ ​like​ ​LinkedIn​ ​for​ ​internships,​ ​jobs,​

​and building profiles.​

​Caution:​​Too​​much​​social​​media​​can​​be​​harmful.​​Students​​should​​balance​
​study time and screen time.​

​5. Positive and Negative Effects of Social Media​

​Positive Effects​

​●​ ​Improves knowledge and awareness.​
​●​ ​Enhances communication skills.​
​●​ ​Builds creativity and confidence.​
​●​ ​Helps in career opportunities.​

​Negative Effects​

​●​ ​Wastes study time if overused.​
​●​ ​Cyberbullying and fake news.​
​●​ ​Health issues like poor eyesight, lack of sleep.​
​●​ ​Privacy problems.​

​Activity:​
​Write​ ​the​ ​names​ ​of​ ​5​ ​social​ ​media​ ​apps​ ​you​​use​​daily​​and​​write​​one​
​benefit of each.​
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​Introduction of Email​

​An​​Email​​(Electronic​​Mail)​​is​​a​​way​​to​​send​​and​​receive​​messages​​using​​the​
​Internet. You can also send photos, files, and documents through email.​

​Uses of Email:​

​●​ ​Sending messages​
​●​ ​Submitting schoolwork​
​●​ ​Sharing files​
​●​ ​Receiving updates from websites or schools​

​Examples of Email Services:​

​●​ ​Gmail​
​●​ ​Yahoo Mail​
​●​ ​Outlook​
​●​ ​Proton Mail​

​To use email, you need an email address like:​ ​saurabh123@gmail.com​
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​Create a Unique Email ID​

​When creating an email account:​
​●​ ​Your email should be easy to remember​
​●​ ​Avoid using special characters like @, #, % in the email name​
​●​ ​Use a combination of your name and numbers​

​Example of a good email ID:​

​saurabh123@gmail.com​

​Avoid:​
​coolboy@123​
​$aurabh#gmail.com​​❌​

​How to Create an Email​

​To create your own email ID, follow these simple steps:​

​Step​ ​1:​ ​Open​ ​a​ ​web​ ​browser​ ​like​ ​Google​ ​Chrome​ ​and​ ​go​ ​to​

​www.gmail.com.​

​Step 2: Click​​on the​​“Create account”​​button and select​​“For myself”​​.​

​1.​ ​A form will appear. Fill in your:​

​●​ ​First Name and Last Name​

​●​ ​Choose a Username (Example: saurabh123)​

​●​ ​Create a Password and confirm it​

​Step 3:​​Click​​Next​​to continue.​

​Step 4:​​Now, enter your​​mobile number​​for security.​

​●​ ​You will get an OTP (One Time Password) on your phone.​

​●​ ​Enter the OTP to verify your number.​

​2.​ ​Next, enter your:​

​●​ ​Date of Birth​

​●​ ​Gender​

​●​ ​(Optional: You can add a recovery email)​

​Step​ ​5:​ ​Click​ ​Next​​,​ ​then​ ​read​ ​and​ ​accept​ ​Google’s​ ​Terms​​and​​Conditions​

​by clicking​​“I Agree”​​. You email is created​
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​Steps to Send an Email:​

​Step 1: Open Gmail​

​👉​​Go to www.gmail.com or open the Gmail app on your​​phone.​
​Step 2: Login​

​👉​​Enter your email ID and password.​

​Step 3: Click on “Compose”​

​👉​​It means “write a new message”.​
​Step 4: Fill the Email:​

​●​ ​To​ ​–​ ​Write​ ​the​ ​email​ ​address​ ​of​ ​the​ ​person​ ​you​ ​want​ ​to​ ​send​ ​(e.g.​
​teacher@gmail.com)​

​●​ ​Subject – Write the title (e.g.​​Homework​​)​
​●​ ​Message​ ​–​ ​Write​ ​your​ ​message​ ​(e.g.​ ​Hello​ ​Ma’am,​ ​I​ ​am​​sending​​my​

​homework.​​)​

​Step 5: Attach File (Optional)​

​👉​​Click the​​📎​​paperclip​​to add a file or photo.​

​Step 6: Click “Send”​

​👉​​Your email will be sent.​

​Activity​​: Email Writing​

​63​​|​​Page​
​Shiv Nadar Institution of Eminence​

​Deemed to be University​



​Basic Financial Skills​

​Unit 9 Financial Literacy​

​What is Financial Literacy?​

​Financial​ ​literacy​ ​means​ ​knowing​ ​how​ ​money​ ​works​ ​so​ ​you​ ​can​ ​earn,​
​save,​ ​spend,​ ​and​ ​grow​ ​it​ ​wisely​​.​ ​A​ ​financially​ ​literate​ ​person​ ​can​ ​make​
​smart​ ​choices​ ​about​ ​banking,​ ​budgeting,​ ​borrowing,​ ​investing,​ ​and​
​protecting money from risks.​

​What is Money?​

​Money​ ​is​ ​anything​ ​people​ ​widely​ ​accept​ ​in​ ​exchange​ ​for​ ​goods​ ​and​
​services. It works because everyone trusts its value.​
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​Key functions:​

​1.​ ​Medium of exchange​​– you trade money for things.​
​2.​ ​Unit of account​​– prices are written in rupees, dollars,​​etc.​
​3.​ ​Store of value​​– you can keep it and use it later.​

​History and Evolution of Money (Barter to Modern System)​

​Period​ ​How​ ​People​
​Traded​

​Proble​
​ms​
​Solved​

​New​
​Problems​

​Barter​
​(ancient)​

​Exchanged​ ​goods​
​directly​ ​(rice​ ​for​
​cloth)​

​None​ ​Hard​ ​to​ ​find​
​matching​ ​needs;​
​no common value​

​Commodity​
​Money​

​Used​​scarce​​items​
​(salt,​ ​shells,​ ​metal​
​pieces)​

​Easier​​to​
​measur​
​e value​

​Heavy, not uniform​

​Metal​​Coins​
​(600 BCE)​

​Standardized​
​gold,​ ​silver,​
​copper coins​

​Durable,​
​divisible​

​Risk​ ​of​ ​theft​ ​&​
​weighty​

​Paper​
​Notes​
​(China​ ​7th​
​cent.)​

​Receipts​ ​for​
​stored​ ​metal​
​became money​

​Lighter​
​to carry​

​Needed​ ​trust​ ​in​
​issuer​

​Bank​​Notes​
​&​ ​Cheques​
​(18th–20th​
​cent.)​

​Banks​​issue​​notes;​
​cheques​ ​move​
​large sums​

​Safer,​
​record​
​keeping​

​Counterfeiting​

​Plastic​
​Cards​
​(1950s)​

​Credit​ ​&​
​debit cards​

​Cashless​
​, global​

​Fees, overspending​

​Digital​ ​&​ ​Mobile​
​Payments​
​(2000s–today)​

​UPI,​ ​e-wallets,​ ​QR​
​codes, crypto​

​Instant,​
​contactless​

​Cyber-fraud,​ ​tech​
​access​
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​Types of Money Today​

​1.​ ​Cash​​– coins & paper notes.​
​2.​ ​Cards​ ​–​ ​Debit​ ​card​ ​(spend​ ​your​ ​bank​ ​balance),​​Credit​​card​​(borrow​

​up to a limit).​
​3.​ ​Digital​ ​Payments​ ​–​ ​UPI​ ​apps​ ​(Ponape,​ ​G​ ​Pay),​ ​mobile​ ​wallets​

​(Paytm),​ ​net-banking,​ ​QR​ ​codes,​ ​NFC​ ​tap-to-pay,​ ​even​
​cryptocurrencies.​

​Needs vs Wants​

​●​ ​Needs​ ​=​ ​must-haves​ ​for​ ​survival​ ​or​ ​basic​ ​well-being​ ​(food,​ ​water,​
​shelter, basic clothes, medicine, school fees).​

​●​ ​Wants​ ​=​​nice-to-haves​​that​​make​​life​​fun​​or​​stylish​​(gaming​​console,​
​branded shoes, fancy vacation).​

​Rule​ ​of​ ​thumb:​ ​Cover​ ​needs​ ​first,​ ​then​ ​decide​ ​how​ ​much​ ​of​​your​​leftover​
​money can go to wants.​
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​What is a Budget?​

​A​ ​budget​ ​is​ ​a​ ​written​ ​plan​ ​that​ ​shows​ ​expected​ ​income​ ​and​ ​planned​
​spending for a period (usually a month). It helps you:​

​1.​ ​See exactly where your money goes.​
​2.​ ​Avoid overspending.​
​3.​ ​Save for goals (new laptop, college, emergency fund).​
​4.​ ​Prepare for surprises​​.​

​Example – Student Budget Chart​

​Pocket Money = ₹1000​
​Items​ ​How Much (₹)​

​Food & Snacks​ ​300​
​Transport​ ​150​
​Mobile Recharge​ ​100​
​School Supplies​ ​200​
​Entertainment​ ​(movies,​

​games)​
​100​

​Savings​ ​150​
​Total​ ​₹1000​
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​Simple 50-30-20 Budget Rule for students​
​●​ ​50 % Needs​
​●​ ​30 % Wants​
​●​ ​20 % Savings & Investments​

​What is Expense?​

​An​​expense​​is​​the​​money​​you​​spend​​to​​buy​​goods​​or​​services.​​Money​​you​
​pay​​for something like food, clothes, school fees,​​travel, etc.​

​Types of Expenses:​

​Type​ ​Example​
​Essential (Needs)​ ​Food, rent, medicine, school fees​

​Non-essential​
​(Wants)​

​Movies,​ ​video​ ​games,​ ​snacks​
​outside​

​What is Tracking Expenses?​

​Tracking​​expenses​​means​​writing​​down​​every​​time​​you​​spend​​money​​—​
​so you can see where your money is going.​

​Example Table:​

​Total Spending :170​
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​Date​ ​What You​
​Bought​

​Amount​
​Spent​

​1 Aug​ ​Snacks​ ​₹50​
​2 Aug​ ​Bus Fare​ ​₹20​
​3 Aug​ ​Stationery​ ​₹100​



​Unit 9.1 importance of saving​

​What is Saving?​

​Saving​ ​means​ ​not​ ​spending​ ​all​ ​the​ ​money​ ​you​ ​have.​ ​Instead,​ ​you​ ​keep​
​some part of it safely to use later when needed.​

​Example:​
​If​ ​you​ ​get​ ​₹500​ ​pocket​ ​money​ ​in​ ​a​ ​month​ ​and​ ​spend​ ​only​ ​₹300,​ ​the​
​₹200you didn’t spend is your savings.​

​Importance of Saving Money​

​1.​ ​Emergency Use​
​●​ ​Money saved can help during sudden needs (medicine, travel, etc.)​
​2.​ ​Achieve Bigger Goals​
​●​ ​You can save to buy useful things like a cycle, book, or school bag.​
​3.​ ​Saving Builds Good Habits​
​●​ ​teaches self-control and how to plan for the future.​
​4.​ ​Reduces Worry​
​●​ ​Saved money gives security and confidence in case of any problem.​
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​What is Investment?​

​●​ ​Investment​ ​means​ ​putting​ ​your​ ​money,​ ​time,​ ​or​ ​effort​ ​into​
​something today so that it can give you more benefits in the future.​

​●​ ​In​​simple​​words,​​investment​​is​​like​​planting​​a​​seed​​.​​Just​​like​​a​​seed​
​grows​​into​​a​​tree​​and​​gives​​fruits​​later,​​investment​​grows​​your​​money​
​and gives returns in the future.​

​●​ ​Investment​​is​​not​​only​​about​​money.​​It​​can​​also​​mean​​investing​​time​
​in​​education​​to​​build​​a​​better​​career,​​or​​investing​​effort​​in​​health​​to​
​stay fit.​

​●​ ​Financial​ ​investment​ ​is​ ​the​ ​most​ ​common​ ​type.​ ​Here,​ ​people​ ​put​
​their​​savings​​into​​banks,​​shares,​​mutual​​funds,​​gold,​​real​​estate,​​or​
​businesses​​with the hope of earning profit.​

​Everyday Examples of Investment​

​●​ ​A student​​invests time in studies​​to get good marks.​
​●​ ​A person​​deposits money in a savings account​​to earn​​interest.​
​●​ ​Families​​buy gold or property​​to use or sell in the​​future.​
​●​ ​Farmers​ ​buy​ ​seeds​ ​and​ ​fertilizers​ ​as​ ​an​ ​investment​ ​for​ ​a​ ​good​

​harvest.​

​Importance of Investment​

​Investment​ ​plays​ ​a​ ​very​ ​important​ ​role​ ​in​ ​personal​ ​life​ ​as​ ​well​ ​as​ ​in​ ​the​
​growth of the economy.​

​1. Future Security​

​●​ ​Investment​​helps​​people​​save​​money​​for​​emergencies,​​retirement,​​or​
​future expenses.​

​●​ ​Example: A person invests in pension schemes for old age security.​

​2. Growth of Money​

​●​ ​Money​ ​kept​ ​at​ ​home​ ​does​ ​not​ ​grow.​ ​But​ ​money​ ​invested​ ​in​ ​banks,​
​mutual funds, or business grows with​​interest, profit,​​or dividends​
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​3. Achieving Goals​

​●​ ​Investment​ ​helps​ ​in​ ​reaching​ ​financial​ ​goals​ ​like​ ​buying​ ​a​ ​house,​
​higher education, starting a business, or traveling abroad.​

​4. National Development​

​●​ ​When​ ​people​ ​invest​ ​in​ ​companies,​ ​banks,​ ​or​ ​government​ ​schemes,​
​that​ ​money​ ​is​ ​used​ ​for​ ​building​ ​industries,​ ​schools,​ ​hospitals,​ ​and​
​infrastructure.​

​Types of Investment (Examples)​

​1.​ ​Bank Investment​​– Fixed Deposits, Savings Accounts.​
​2.​ ​Stock Market​​– Buying shares of companies.​
​3.​ ​Mutual​ ​Funds​ ​–​ ​Professional​ ​management​ ​of​ ​your​ ​money​ ​in​

​different sectors.​
​4.​ ​Real Estate​​– Buying land, houses, or shops.​
​5.​ ​Gold and Silver​​– Traditional investment in India.​
​6.​ ​Education​​– Investment of time and money for future​​career.​

​Activities:​
​●​ ​Track Your Weekly Expenses​
​●​ ​Create a personal weekly budget chart​
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​Smart Spending​

​Smart​ ​spending​ ​means​ ​using​ ​money​ ​wisely​ ​–​ ​buying​ ​things​ ​that​ ​are​
​important, useful, and within your budget.​

​Making Smart Buying Decisions​

​1.​ ​Ask yourself before buying:​

​●​ ​Do I really need this?​
​●​ ​Is there a better option or brand?​

​2.​ ​Compare prices:​

​●​ ​Don’t buy from the first shop. Compare online or with friends​​.​

​3.​ ​Choose quality over looks​

​●​ ​A good-quality product lasts longer and saves money.​
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​Identifying Discounts and Offers​

​1.​ ​Look for genuine offers (like Buy 1 Get 1, 20% off, student discounts)​
​2.​ ​Read terms carefully – sometimes offers have conditions​
​3.​ ​Don't buy unnecessary things just because they are on discount​

​Understanding Hidden Costs​

​1.​ ​Some products may have extra costs like:​

​●​ ​Delivery charges​
​●​ ​Installation fees​
​●​ ​Monthly service charges​

​2.​ ​Always check the final total cost before buying.​

​Planning for the Future​

​Financial Goal Setting​

​1.​ ​Set a goal (like buying a toy, cycle, or phone)​
​2.​ ​Find out how much it costs​
​3.​ ​Decide how much you will save each week or month​

​Example:​

​Goal:​​Buy a school bag worth ₹600​
​●​ ​Save ₹100 every month for 6 months​
​●​ ​After 6 months, you can buy the bag​
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​Basic Concept of Interest and Growth​

​1.​ ​If​ ​you​ ​keep​ ​your​ ​money​ ​in​ ​a​ ​bank,​ ​you​ ​get​ ​extra​ ​money​ ​called​
​interest​

​2.​ ​This is how your money grows over time​

​Example:​

​If​ ​you​ ​keep​ ​₹1000​ ​in​ ​the​ ​bank​ ​with​ ​5%​ ​interest​ ​yearly,​ ​after​​1​​year​​you​​get​
​₹50 extra — so now you have ₹1050.​
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​Unit 10 Banking and Digital Payments​

​What is a Bank?​

​A​ ​bank​ ​is​ ​a​ ​place​ ​where​ ​people​ ​keep​ ​their​ ​money​ ​safely.​ ​Banks​ ​help​ ​us​
​deposit​ ​money,​ ​withdraw​ ​money,​ ​and​ ​provide​ ​loans.​ ​They​​also​​allow​​us​​to​
​transfer money and pay bills.​

​Example:​​If​​you​​earn​​money​​and​​want​​to​​save​​it​​securely,​​you​​can​​deposit​​it​
​into a bank.​

​Why use a Bank?​

​●​ ​Safe place for money Deposit​
​●​ ​Helps in managing finances​
​●​ ​Offers interest on savings​

​Types of Bank Account​

​There are mainly two types of bank accounts:​

​1.​ ​Savings Account​
​●​ ​Used by individuals to save money.​
​●​ ​Earns interest on the saved money.​
​●​ ​You can deposit and withdraw money anytime.​

​2.​ ​Current Account​
​●​ ​Mostly used by businesses.​
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​●​ ​No interest is usually given.​
​●​ ​Allows frequent and large transactions.​

​Other accounts include Fixed Deposit and Recurring Deposit accounts​​.​

​What is Digital Payment?​

​Digital​​payment​​means​​paying​​money​​using​​electronic​​methods​​instead​​of​
​cash. It allows users to pay using mobile phones, computers, or cards​​.​

​Example: Paying for groceries using a UPI app instead of cash.​

​Why Use Digital Payments?​

​●​ ​Fast and convenient​
​●​ ​No need to carry cash​
​●​ ​Available anytime, anywhere​
​●​ ​Good during emergencies or lockdowns​

​Types of Digital Payments​

​1.​ ​UPI (Unified Payments Interface)​
​●​ ​Money transfer using mobile apps like Phone Pe, Google Pay, Paytm.​

​2.​ ​Debit/Credit Cards​
​●​ ​Swipe cards used for online and offline payments.​

​3.​ ​Mobile Wallets​
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​●​ ​Apps like Paytm, Amazon Pay store money to pay easily.​

​4.​ ​Internet Banking​
​●​ ​Pay bills, transfer funds using the bank's website.​

​5.​ ​QR Code Payments​
​●​ ​Scan and pay using mobile camera and UPI app.​

​Benefits of Digital Payments​

​1.​ ​Fast and easy to use​
​2.​ ​No need to carry cash​
​3.​ ​Available 24x7​
​4.​ ​Useful for online shopping​
​5.​ ​Safe and trackable transactions​

​Digital Safety Rules​

​To stay safe while making digital payments, follow these rules:​

​1.​ ​Keep your PIN, password and OTP secret​
​2.​ ​Don’t share personal banking details with anyone​
​3.​ ​Use only trusted apps and websites​
​4.​ ​Always log out after using online banking​
​5.​ ​Check bank messages for any unknown transaction​
​6.​ ​Update apps regularly for better security​

​Activities:​
​●​ ​how to digital payment by the phone pe, Paytm and G pay​
​●​ ​Assessment on Digital Payment​
​●​ ​Assessment on bank​
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​Soft Skills & Life skills​

​Unit 11 Soft Skills​

​What are Soft Skills?​

​Soft​ ​skills​ ​are​ ​personal​ ​qualities​ ​and​ ​behaviours​ ​that​ ​help​ ​people​
​communicate, work well with others, and succeed in life and work.​

​Examples of Soft Skills:​

​●​ ​Communication​
​●​ ​Teamwork​
​●​ ​Time Management​
​●​ ​Problem Solving​
​●​ ​Leadership​
​●​ ​Positive Attitude​
​●​ ​Confidence​

​Why are Soft Skills Important?​

​●​ ​Help you work better in groups​
​●​ ​Improve your speaking and listening​
​●​ ​Make you more responsible and confident​

​●​ ​Help you handle difficult situations calmly​
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​Difference Between Hard Skills and Soft Skills​

​Feature​ ​Hard Skills​ ​Soft Skills​

​Meaning​ ​Technical​ ​or​
​job-specific abilities​

​Personal and social abilities​

​Learned​
​Through​

​School,​ ​training,​
​courses​

​Practice,​ ​experience,​ ​daily​
​life​

​Examples​ ​Typing,​ ​coding,​
​math, painting​

​Communication,​
​teamwork,​

​Measured By​ ​Exams, certificates​ ​Observation, behaviour​

​Important​
​For​

​Doing the job​ ​Succeeding at the job​

​Example:​

​A​ ​computer​ ​operator​ ​needs​ ​hard​ ​skills​ ​to​ ​use​ ​MS​ ​Excel,​ ​but​ ​also​
​needs soft skills to talk to customers politely.​

​Importance of Soft Skills in School Life​

​●​ ​Helps you make friends​
​●​ ​Improves classroom behaviour​
​●​ ​Teaches you to listen and understand​
​●​ ​Builds self-confidence and respect​

​Importance of Soft Skills in Career​

​●​ ​Every job requires teamwork, communication, and problem-solving​
​●​ ​Employers look for polite, disciplined, and responsible people​
​●​ ​Helps in interviews, group discussions, and presentation​

​What is Analytical Thinking​

​Analytical​ ​thinking​ ​means​ ​breaking​ ​a​ ​problem​ ​into​ ​smaller​ ​parts,​
​understanding​ ​each​ ​part,​ ​and​ ​then​ ​finding​ ​a​ ​solution​ ​based​ ​on​​logic​​and​
​facts. It helps you think clearly and step by step.​
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​Why is Analytical Thinking Important?​

​●​ ​Helps you solve problems better​
​●​ ​Makes you think logically​
​●​ ​Improves decision-making skills​
​●​ ​Prepares you for exams, life, and future jobs​

​Example 2: Problem-Solving with Analytical Thinking​

​Problem: You are always late to school.​

​Break it down step by step:​

​1.​ ​Why are you late?​​→ You wake up late​

​2.​ ​Why do you wake up late?​​→ You sleep late​

​3.​ ​Why do you sleep late?​​→ You watch mobile till 11​​PM​

​4.​ ​What can you change?​​→ Stop using mobile after 9 PM​

​5.​ ​What​ ​is​ ​the​ ​result?​ ​→​ ​Sleep​ ​early,​ ​wake​ ​up​ ​early,​ ​reach​ ​school​ ​on​

​time​

​Activity:​
​What should I do (give situation on analytical thinking)​
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​Unit 12 Life skills​

​What is Decision-Making?​

​Decision-making​​is​​the​​process​​of​​thinking​​carefully​​and​​choosing​​the​​best​
​possible​​option​​from​​different​​available​​choices.​​It​​involves​​understanding​​a​
​problem,​ ​thinking​ ​of​ ​different​ ​solutions,​ ​and​ ​selecting​ ​the​​one​​that​​works​
​best.​

​Why is Decision-Making Important?​

​●​ ​Helps in solving everyday problems​
​●​ ​Makes you more responsible and confident​
​●​ ​Improves thinking power​
​●​ ​Helps you avoid mistakes and save time​

​Example 1: Real-Life Decision​

​Situation:​
​You​ ​have​ ​₹50.​ ​You​ ​can​ ​either​ ​buy​ ​a​ ​notebook​ ​or​ ​a​ ​pen.​ ​You​ ​don’t​
​have both at home.​

​How to decide?​

​1.​ ​Think: What is more important right now?​
​2.​ ​Ask: Do I have an old notebook I can use?​
​3.​ ​Decide: If your old pen still works, you choose the notebook.​
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​Steps of Decision-Making:​
​1.​ ​Identify the problem​​– What is the situation?​

​2.​ ​Collect information​​– What are your options?​

​3.​ ​Think​ ​about​ ​outcomes​ ​–​ ​What​ ​will​ ​happen​ ​if​ ​you​ ​choose​ ​each​

​option?​

​4.​ ​Choose the best solution​​– Pick the smartest one.​

​5.​ ​Act –​​Apply your decision.​

​Conflict Management​
​Conflict means a disagreement or fights between two or more people.​
​Conflict​ ​Management​ ​means​​solving​​that​​disagreement​​in​​a​​peaceful​​and​
​fair way.​

​How to Manage Conflict:​

​Step​ ​What to Do​

​1. Stay Calm​ ​Don’t shout or get angry​

​2. Listen​ ​Understand the other person’s side​

​3. Talk Clearly​ ​Use polite words to express your feelings​

​4.​ ​Find​ ​a​
​Solution​

​Agree on a way to solve the problem​

​5.​ ​Ask​ ​for​
​Help​

​If needed, talk to a teacher or adult​
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​Example:​

​Two students argue over who should clean the blackboard.​
​They talk calmly, and decide to take turns every day.​
​Conflict is managed respectfully.​
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​What is Teamwork?​

​Teamwork​​means​​working​​together​​with​​others​​to​​achieve​​a​​common​​goal.​
​It involves cooperation, sharing ideas, and helping each other.​

​Why Teamwork Matters:​

​Benefit​ ​Explanation​

​Better Results​ ​People​ ​working​ ​together​ ​finish​ ​tasks​ ​faster​ ​and​
​better​

​New Ideas​ ​Team members bring different ideas and views​

​Builds Respect​ ​Everyone learns to listen and value others​

​Helps in Real Life​ ​Teamwork​​is​​needed​​in​​school​​projects,​​sports,​​and​
​jobs​

​Real-Life Example:​

​In​ ​a​ ​science​ ​project,​ ​if​ ​one​ ​student​ ​writes,​ ​another​ ​draws,​ ​and​ ​another​
​presents, the team finishes better than working alone.​
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​Qualities of a Good Team Member:​
​●​ ​Cooperates with others​
​●​ ​Shares work and ideas​
​●​ ​Listens respectfully​
​●​ ​Helps others when needed​
​●​ ​Avoids fights or blaming​

​What is Leadership?​

​Leadership​ ​is​ ​the​​ability​​to​​guide,​​support,​​and​​inspire​​others​​in​​a​​group.​
​A leader helps the team stay focused and work together.​

​Qualities of a Good Leader:​

​Quality​ ​Description​

​Confidence​ ​Believes​ ​in​ ​self​ ​and​ ​encourages​
​others​

​Honesty​ ​Tells the truth and is fair​
​Responsibility​ ​Takes​ ​care​ ​of​ ​the​ ​team​ ​and​ ​its​

​work​
​Communicatio​
​n​

​Speaks clearly and listens well​

​Problem Solver​ ​Helps​ ​the​ ​team​ ​when​ ​there’s​ ​a​
​problem​

​Respectful​ ​Treats​ ​everyone​ ​equally​ ​and​
​kindly​

​Decision-Maker​ ​Makes​ ​smart​ ​choices​ ​for​ ​the​
​group​
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​Example of Leadership:​

​A​ ​class​ ​monitor​ ​who​ ​listens​​to​​classmates,​​speaks​​to​​teachers​​politely,​​and​
​helps solve issues is showing leadership.​

​Activity:​
​Group Discussion – What Makes a Good Leader?​
​Activity:​
​What should i do (give situation on decision making)​
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​Unit 12.1 What is Personal Development?​

​Personal​ ​Development​ ​means​ ​working​ ​on​ ​your​ ​thoughts,​ ​behaviour,​ ​and​
​habits​ ​to​ ​become​ ​a​ ​better​ ​version​ ​of​ ​yourself.​ ​It​ ​helps​ ​you​ ​grow​​mentally,​
​emotionally, and socially.​

​1. Self-Awareness​

​Self-awareness​ ​means​ ​knowing​ ​yourself—your​ ​strengths,​ ​weaknesses,​
​emotions,​ ​and​ ​goals.​ ​It​ ​helps​ ​you​ ​understand​ ​how​ ​your​ ​actions​ ​affect​
​others.​

​Why It’s Important:​

​●​ ​Helps you make better decisions​
​●​ ​Improves relationships with others​
​●​ ​Helps you control your emotions​

​Example:​

​If​​you​​know​​that​​you​​get​​angry​​quickly,​​you​​can​​learn​​to​​stay​​calm​​in​​tough​
​situations. That is being self-aware​​.​
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​2. Self-Motivation​

​Self-motivation​ ​means​ ​the​ ​inner​ ​drive​ ​to​ ​do​ ​something​ ​without​ ​being​
​pushed​​by​​others.​​It’s​​the​​power​​that​​helps​​you​​stay​​focused​​on​​your​​goals​
​even when things are hard.​

​Why It’s Important:​

​●​ ​Helps you work hard even without rewards​
​●​ ​Builds confidence​
​●​ ​Helps you reach goals like good marks, skills, or success​

​Example:​

​If​ ​you​ ​want​ ​to​ ​improve​ ​in​ ​English,​ ​you​ ​read​ ​every​ ​day​ ​even​ ​when​ ​no​ ​one​
​tells you. That’s self-motivation.​

​Tips to Improve Self-Motivation:​

​●​ ​Set small daily goals (e.g., “I will finish my homework before dinner”)​
​●​ ​Reward yourself after completing a task​
​●​ ​Stay positive and avoid negative thoughts​

​3. Stress Management​

​Stress​ ​management​ ​means​ ​learning​ ​how​ ​to​ ​stay​ ​calm​ ​and​ ​in​ ​control​
​during difficult situations like exams, fights, or pressure.​
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​Why It’s Important:​

​●​ ​Keeps your mind and body healthy​
​●​ ​Helps you think clearly​
​●​ ​Stops small problems from becoming big​

​Common Reasons for Stress in Students:​

​●​ ​Exams and studies​
​●​ ​Too many tasks at once​
​●​ ​Lack of sleep​

​How to Manage Stress:​

​Technique​ ​Description​

​Deep​
​Breathing​

​Take​ ​slow,​ ​deep​ ​breaths​ ​to​ ​calm​ ​your​
​mind​

​Time​
​Management​

​Make​ ​a​ ​schedule​ ​to​ ​avoid​ ​last-minute​
​pressure​

​Talk​ ​to​
​Someone​

​Share​ ​your​ ​feelings​ ​with​ ​parents​ ​or​
​teachers​

​Take Breaks​ ​Relax​ ​after​ ​study—walk,​ ​stretch,​ ​listen​
​to music​

​Sleep Well​ ​7–8​ ​hours​ ​of​ ​sleep​ ​reduce​ ​stress​
​naturally​

​Activity:​
​Create Strengths & Weaknesses Chart​
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​Unit 13 Health & Wellness​

​What is health?​

​Health means the complete well-being of a person –​​physically, mentally,​
​and socially​​.​
​It is not only about being free from illness but also about living a balanced​
​and active life.​
​Good health allows us to work, study, and enjoy life happily.​
​It includes​​physical health​​(body fitness),​​mental​​health​​(positive​
​thinking), and​​social health​​(good relationships).​
​A healthy lifestyle with proper food, exercise, rest, and hygiene keeps us​
​healthy.​

​Types of Health:​

​1.​ ​Physical health.​
​2.​ ​Mental health.​
​3.​ ​Spiritual health.​

​Physical health​

​Physical​ ​health​ ​means​ ​the​ ​overall​ ​condition​ ​of​ ​your​ ​body​ ​—​ ​how​ ​well​ ​it​
​functions,​ ​how​ ​strong​ ​it​ ​is,​ ​and​ ​how​ ​well​ ​you​ ​can​ ​perform​ ​everyday​
​activities without getting tired or sick.​
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​Key Aspects of Physical Health:​

​1.​ ​Healthy Food​
​●​ ​Your body needs energy to grow and work properly.​
​●​ ​Eat​ ​a​ ​balanced​ ​diet​ ​that​ ​includes​ ​fruits,​ ​vegetables,​ ​milk,​ ​pulses,​

​cereals, etc.​
​●​ ​Avoid junk food and too much sugar or oily food.​

​2.​ ​Exercise and Physical Activity​

​●​ ​Regular movement helps muscles and bones stay strong.​
​●​ ​Activities​ ​like​ ​walking,​ ​yoga,​ ​running,​ ​cycling,​ ​and​ ​sports​ ​improve​

​blood flow and make your heart strong.​

​3.​ ​Hygiene and Cleanliness​

​●​ ​Keeping your body clean prevents infections and diseases.​
​●​ ​Brush​ ​your​ ​teeth​ ​twice​ ​a​ ​day,​ ​take​ ​a​ ​bath​ ​daily,​ ​wash​ ​your​ ​hands​

​before eating.​

​4.​ ​Rest and Sleep​
​●​ ​Sleep allows the body to repair itself and stay fresh.​
​●​ ​Students should get at least 7–9 hours of sleep every night.​

​5.​ ​Avoiding Harmful Habits​
​●​ ​Stay away from smoking, alcohol, and unhealthy eating habits.​
​●​ ​Limit screen time (TV/mobile) and avoid laziness.​

​Benefits of Good Physical Health:​

​●​ ​You stay strong and active all day​
​●​ ​Your body can fight diseases better (strong immunity)​
​●​ ​You can study, play, and focus more effectively​
​●​ ​You feel happy and confident​
​●​ ​It helps in growing properly — both height and strength​
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​What is Mental Health?​

​Mental​ ​health​ ​is​ ​the​ ​state​ ​of​ ​our​​mind​​and​​emotions​​.​​It​​includes​​how​​we​
​think​​,​ ​feel​​,​ ​and​ ​act​​.​ ​It​ ​also​ ​helps​ ​us​ ​cope​ ​with​​stress,​​relate​​to​​others,​​and​
​make healthy choices in life.​

​Key Points about Mental Health:​

​1.​ ​Good Mental Health Means:​

​●​ ​Feeling happy or content.​
​●​ ​Being able to handle daily stress.​
​●​ ​Having good relationships.​
​●​ ​Being productive in work or studies.​

​2.​ ​Poor Mental Health May Include:​

​●​ ​Feeling sad or low for a long time.​
​●​ ​Anxiety, fear, or worry.​
​●​ ​Trouble sleeping or eating.​
​●​ ​Difficulty in concentrating.​

​Common Mental Health Issues​

​●​ ​Depression:​​Persistent sadness and loss of interest​​.​
​●​ ​Anxiety:​​Constant worry or fear.​
​●​ ​Stress:​​Feeling overwhelmed due to pressure.​
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​●​ ​Mood Swings​

​Why is Mental Health Important?​

​●​ ​It improves quality of life.​
​●​ ​Helps in clear thinking and decision making.​
​●​ ​Build better relationships.​
​●​ ​Supports physical health.​
​●​ ​Increases confidence and focus.​

​Tips to Maintain Mental Health​

​1.​ ​Talk to someone –​​Share your feelings​​.​
​2.​ ​Exercise daily –​​Physical activity boosts mood.​
​3.​ ​Eat healthy –​​Good nutrition supports the brain​​.​
​4.​ ​Get enough sleep​​– Sleep repairs mind and body.​
​5.​ ​Practice mindfulness or meditation.​

​What is Spiritual Health?​

​●​ ​Spiritual​ ​health​ ​means​ ​the​ ​connection​ ​of​ ​a​ ​person​ ​with​ ​their​ ​mind,​
​soul, values, and purpose in life.​

​●​ ​It​ ​is​ ​about​ ​finding​ ​inner​ ​peace,​ ​developing​ ​faith,​ ​and​ ​being​ ​able​ ​to​
​differentiate between right and wrong.​

​●​ ​Just​ ​like​ ​physical​ ​and​ ​mental​ ​health,​ ​spiritual​ ​health​ ​is​ ​also​ ​an​
​important part of overall well-being.​

​Key Aspects of Spiritual Health​

​1.​ ​Self-awareness – Knowing yourself, your strengths, and weaknesses.​
​2.​ ​Positive​ ​thinking​ ​–​ ​Keeping​ ​hope​ ​and​ ​patience​ ​even​ ​in​ ​difficult​

​situations.​
​3.​ ​Values​ ​and​ ​morality​ ​–​ ​Choosing​ ​the​ ​right​ ​path​ ​and​ ​doing​ ​good​

​deeds.​
​4.​ ​Peace and balance – Staying calm and avoiding anger or stress.​
​5.​ ​Connection​​with​​nature​​and​​faith​​–​​Through​​meditation,​​yoga,​​prayer,​

​or reflection.​

​Importance of Spiritual Health​

​1.​ ​Gives inner peace – Prayer and meditation calm the mind.​
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​2.​ ​Reduces stress – Helps in facing life’s challenges positively.​
​3.​ ​Develops​ ​a​ ​positive​ ​attitude​ ​–​ ​Encourages​ ​optimistic​ ​thinking​ ​in​

​every situation.​
​4.​ ​Builds​ ​better​ ​relationships​ ​–​ ​Promotes​ ​kindness,​ ​empathy,​ ​and​

​forgiveness.​
​5.​ ​Provides purpose in life – Helps to live with clarity and motivation.​

​Ways to Improve Spiritual Health​

​●​ ​Meditation and Yoga – Practice daily for 10–15 minutes.​
​●​ ​Prayer and faith – Stay connected to your belief system or God.​
​●​ ​Reading inspirational books – Spiritual or motivational reading.​
​●​ ​Helping others – Volunteering, kindness, and charity.​
​●​ ​Spending time in nature – Increases peace, positivity, and energy.​
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​What is​​Nutrition​

​Nutrition​ ​is​ ​the​ ​process​ ​of​ ​getting​ ​the​ ​right​ ​kind​ ​of​ ​food​ ​and​ ​nutrients​
​your​ ​body​ ​needs​ ​to​ ​grow,​ ​stay​ ​healthy,​ ​and​ ​work​ ​properly​

​Why is Nutrition Important?​

​●​ ​Gives energy to the body​
​●​ ​Helps in growth and development​
​●​ ​Keeps bones, muscles, and organs strong​
​●​ ​Increases immunity to fight diseases​
​●​ ​Keeps mind and body active​
​Essential Nutrients in Food:​

​Nutrient​ ​Use in Body​ ​Sources​
​Carbohydrates​ ​Gives energy​ ​Rice,​ ​chapati,​

​bread, potatoes​
​Proteins​ ​Builds muscles and body parts​ ​Milk,​ ​eggs,​

​pulses, meat​
​Fats​ ​Gives​ ​energy​ ​and​ ​helps​ ​store​

​vitamins​
​Ghee, oil, nuts​

​Vitamins​ ​Protect​ ​from​ ​diseases​ ​and​​keep​
​body healthy​

​Fruits,​
​vegetables​

​Minerals​ ​Help​ ​in​ ​bone,​ ​blood,​ ​and​ ​body​
​functions​

​Salt,​ ​milk,​
​spinach​

​Water​ ​Keeps body hydrated and cool​ ​Clean​ ​drinking​
​water, fruits​

​Fibre​ ​Helps in digestion​ ​Whole​ ​grains,​
​fruits, vegetables​
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​What is a Balanced Diet?​

​A​ ​balanced​ ​diet​ ​includes​ ​food​ ​from​ ​all​ ​major​ ​nutrient​ ​groups​ ​in​ ​the​​right​
​amount — not too much, not too little.​

​Poor Nutrition Can Cause:​

​●​ ​Weakness or tiredness​
​●​ ​Poor growth in children​
​●​ ​Frequent illness​
​●​ ​Obesity or being underweight​
​●​ ​Poor concentration in studies​
​Healthy Nutrition Habits:​

​●​ ​Eat fresh fruits and vegetables daily​
​●​ ​Drink plenty of water​
​●​ ​Avoid junk food, soft drinks, and too much sugar​
​●​ ​Have regular meals at the right time​
​●​ ​Include milk, grains, and protein-rich food in diet​
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​What is Yoga?​

​Yoga​ ​is​ ​a​ ​physical,​ ​mental,​ ​and​​spiritual​​practice​​that​​helps​​keep​​the​​body​
​strong and the mind calm.​

​Benefits of Yoga:​

​Benefit​ ​Explanation​
​Improves​
​flexibility​

​Makes the body more flexible and active​

​Builds strength​ ​Strengthens muscles and joints​
​Reduces stress​ ​Makes the mind calm and peaceful​
​Improves​
​breathing​

​Helps​ ​in​ ​better​ ​control​ ​of​ ​breath​
​(Pranayama)​

​Boosts​
​concentration​

​Helps​ ​in​ ​focusing​ ​better​ ​on​ ​studies​ ​or​
​work​

​Keeps​ ​you​
​healthy​

​Helps​ ​prevent​ ​many​ ​diseases​ ​and​
​improves digestion​
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​Examples of Simple Yoga Asanas (Poses):​

​Asana Name​ ​Use​
​Tadasana​
​(Mountain)​

​Improves posture and balance​

​Vrikshasana​
​(Tree)​

​Builds​ ​concentration​ ​and​
​balance​

​Bhujangasana​
​(Cobra)​

​Strengthens​​back​​and​​improves​
​posture​

​Vajrasana​ ​Good for digestion​

​What is Meditation?​

​Meditation​​is​​a​​way​​to​​relax​​your​​mind​​and​​focus​​on​​your​​breath,​​thoughts,​
​or a mantra.​

​Benefits of Meditation:​

​●​ ​Reduces anxiety and stress​
​●​ ​Improves focus and memory​
​●​ ​Increases self-awareness​
​●​ ​Helps with better sleep​
​●​ ​Makes the mind calm and peaceful​
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​How to Practice Meditation​

​1.​ ​Sit comfortably in a quiet place​
​2.​ ​Close your eyes​
​3.​ ​Breathe slowly and deeply​
​4.​ ​Focus on your breath or a calming word​
​5.​ ​Do it for 5–10 minutes daily​

​Activity:​
​Create a daily Routine Chart & Chapter Revision​
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​Communication Skills​

​Unit 14 Communication Skills​

​What is Communication?​

​Communication​ ​means​ ​the​ ​way​ ​we​ ​send​ ​and​ ​receive​ ​information​ ​using​
​words, actions, or writing.​

​Why it's important​​:​

​Good​ ​communication​ ​helps​ ​us​ ​express​ ​ideas​ ​clearly,​ ​understand​ ​others,​
​and build strong relationships.​

​1.​ ​Verbal and Non-verbal Communication​

​Type​ ​Meaning​ ​Example​
​Verbal​ ​Using spoken or written words​ ​Talking​ ​to​ ​a​ ​teacher,​

​writing an email​
​Non-verb​
​al​

​Using​ ​body​ ​language,​ ​gestures,​
​and expressions​

​Smiling,​ ​nodding,​ ​hand​
​gestures​

​Verbal Communication​

​●​ ​Includes speaking and writing​
​●​ ​Requires clear pronunciation and correct grammar​
​●​ ​Example: Answering in class, giving a speech​
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​Non-verbal Communication​

​●​ ​Includes facial expressions, eye contact, body movement​
​●​ ​Example: Thumbs up to show approval, frown to show confusion​

​2. Listening Skills​

​Listening​ ​is​ ​as​​important​​as​​speaking​​in​​communication.​​It​​means​​paying​
​full attention to the speaker.​

​Good Listening Habits​​:​

​●​ ​Look at the speaker​
​●​ ​Don’t interrupt​
​●​ ​Nod or smile to show you're listening​
​●​ ​Ask questions if you don’t understand​

​3. Public Speaking​

​Public​ ​speaking​ ​means​ ​speaking​ ​in​ ​front​ ​of​ ​a​ ​group​ ​of​ ​people​ ​with​
​confidence and clarity.​

​Tips for Good Public Speaking:​

​●​ ​Speak slowly and clearly​
​●​ ​Make eye contact with the audience​
​●​ ​Use simple words​
​●​ ​Don’t panic or rush​
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​4. Writing Skills​

​Writing​​is a way to express thoughts using words on​​paper or a screen.​
​Good Writing Includes:​

​●​ ​Clear and simple sentences​
​●​ ​Proper punctuation and grammar​
​●​ ​Organized structure (beginning, middle, end)​

​Digital Communication​

​Digital​ ​communication​ ​means​ ​exchanging​ ​information​ ​using​ ​digital​
​devices​ ​and​​the​​internet​​instead​​of​​face-to-face​​or​​handwritten​​methods.​
​It includes messages, emails, video calls, and social media.​

​Explanation​

​●​ ​In old times, people used​​letters​​to communicate.​
​●​ ​Today,​ ​we​ ​use​ ​mobile​ ​phones,​ ​computers,​ ​and​ ​the​ ​internet​ ​to​

​connect instantly.​
​●​ ​It​ ​can​ ​be​ ​formal​ ​(official​ ​emails,​ ​online​ ​meetings)​ ​or​ ​informal​

​(chatting with friends).​

​Types of Digital Communication​

​●​ ​Text-based:​​Email, WhatsApp, SMS.​
​●​ ​Audio-based:​​Voice calls, audio notes.​
​●​ ​Video-based:​​Google Meet, Zoom, video calls.​
​●​ ​Social Media:​​YouTube, Instagram, Facebook.​

​Advantages​

​●​ ​Very​​fast​​and saves time.​
​●​ ​Can connect with anyone in the​​world​​.​
​●​ ​Easy to​​share photos, videos, and files​​.​
​●​ ​Helps in​​online learning and teamwork​​.​

​Safe Use of Digital Communication​

​●​ ​Do not share​​passwords or personal details​​.​
​●​ ​Always use​​polite and respectful language​​.​
​●​ ​Do not talk to​​strangers online​​.​
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​●​ ​Think before you post anything on social media.​
​Importance of Asking Questions​

​Asking​​questions​​means​​showing​​curiosity​​and​​the​​desire​​to​​learn​​more​
​by seeking answers from teachers, parents, or books.​

​Explanation​

​●​ ​Questions help us​​understand concepts clearly​​.​
​●​ ​They show that a student is​​interested and active​​in learning.​
​●​ ​Every​ ​great​ ​discovery​ ​started​ ​with​ ​a​ ​question​ ​(e.g.,​ ​Why​ ​does​ ​an​

​apple fall down? → Newton discovered gravity).​

​Why Asking Questions is Important​

​●​ ​Increases​​knowledge​​.​
​●​ ​Removes​​confusion and doubt​​.​
​●​ ​Builds​​confidence​​in class.​
​●​ ​Encourages​​thinking and creativity​​.​

​Types of Questions​

​●​ ​Closed Questions:​​Can be answered in one word (Yes/No).​
​●​ ​Open Questions:​​Need explanation (Why, How, What).​
​●​ ​Smart Questions:​​Clear and specific.​

​Examples​

​●​ ​Closed: “Is the Earth round?”​
​●​ ​Open: “Why is the Earth round?”​
​●​ ​Smart:​ ​“What​ ​is​ ​the​ ​difference​ ​between​ ​Earth’s​ ​rotation​ ​and​

​revolution?”​

​Importance of Saying No​

​Saying​​No​​means​​refusing​​politely​​when​​something​​is​​wrong,​​unsafe,​​or​
​unnecessary​​.​

​Explanation​
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​●​ ​Sometimes​​friends,​​classmates,​​or​​strangers​​may​​ask​​us​​to​​do​​things​
​that are not good.​

​●​ ​In such cases, it is important to​​say No firmly and​​politely​​.​
​●​ ​Saying No helps us​​stay safe and confident​​.​
​Why Saying No is Important​

​●​ ​Protects us from​​peer pressure​​(friends forcing bad​​habits).​
​●​ ​Saves our​​time and energy​​for good work.​
​●​ ​Helps us​​set boundaries​​and earn respect.​
​●​ ​Keeps us​​safe online​​from strangers or fake people.​

​When to Say No​

​●​ ​If someone asks for your​​password or personal info​​online​​.​
​●​ ​If a friend asks you to​​cheat or copy homework​​.​
​●​ ​If someone forces you to​​skip school or do bad habits​​.​
​●​ ​If you are already​​busy or tired​​.​

​How to Say No Politely​

​●​ ​“Sorry, I can’t do this.”​
​●​ ​“No, this is not right.​
​●​ ​“I don’t feel comfortable doing this.”​
​●​ ​Say it​​calmly but confidently​​.​

​Examples (Role-play situations)​

​●​ ​A​ ​stranger​ ​online​ ​ask:​ ​“Send​ ​me​ ​your​ ​photo.”​​→​​Answer:​​“No,​​I​​don’t​
​share my photos with strangers.”​

​●​ ​A​ ​friend​ ​says:​ ​“Skip​​class​​and​​come​​with​​me.”​​→​​Answer:​​“No,​​I​​want​
​to attend class.”​

​●​ ​Peer​ ​says:​ ​“Smoke​ ​this,​ ​just​ ​once.”​ ​→​ ​Answer:​ ​“No,​ ​it​ ​is​ ​harmful​ ​for​
​health.”​

​Activities:​
​Practice Listening, Speaking, and Writing​
​Self-Introduction Practice​
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​Social sensitive skills​

​Unit 15 Volunteering & Community Engagement​

​Introduction to Volunteering​

​Volunteering​ ​means​ ​helping​ ​others​​without​​expecting​​money​​.​​It​​can​​be​
​small,​ ​like​ ​helping​ ​a​ ​friend,​ ​or​ ​big,​ ​like​ ​planting​ ​trees​ ​or​ ​helping​ ​in​ ​the​
​community.​

​Why Volunteering is Important:​

​●​ ​Helps people and makes the community better​
​●​ ​Builds skills like teamwork, kindness, and leadership​
​●​ ​Makes us responsible and happy​

​Examples of Volunteers:​

​●​ ​Mahatma Gandhi – worked for social change​
​●​ ​Malala Yousafzai – worked for girls’ education​
​●​ ​Local volunteers – organize cleanliness drives or plant trees​
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​What is a community:​

​A​ ​community​ ​is​ ​a​ ​group​ ​of​ ​people​ ​who​ ​live​ ​or​ ​work​ ​together​​,​ ​share​
​common interests, needs, or goals, and support each other.​

​Key Points:​

​●​ ​People​ ​in​ ​a​ ​community​ ​often​ ​live​ ​in​ ​the​ ​same​ ​area​ ​like​ ​a​
​neighbourhood, village, or town.​

​●​ ​They may share​​common resources​​, like schools, parks,​​or markets.​
​●​ ​Communities​ ​can​ ​also​ ​be​ ​based​ ​on​​common​​interests​​like​​a​​hobby​

​group, club, or online group.​
​●​ ​Members of a community​​help and care for each other​​.​

​Example:​

​●​ ​Your​ ​school​ ​is​ ​a​ ​community​ ​because​ ​students,​ ​teachers,​ ​and​ ​staff​
​work together and share common goals.​

​●​ ​A​ ​village​ ​or​ ​town​ ​is​​a​​community​​because​​people​​live​​nearby,​​share​
​facilities, and support each other.​

​Understanding Society:​

​Society​​includes​​all​​the​​communities​​together​​.​​Volunteering​​helps​​society​
​grow in a better way.​
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​Key Points:​

​●​ ​A society is made up of​​many communities​​.​
​●​ ​People​ ​in​ ​a​ ​society​ ​work,​ ​cooperate,​ ​and​ ​follow​ ​rules​ ​to​ ​live​

​together peacefully.​
​●​ ​Society​ ​includes​ ​families,​ ​schools,​ ​workplaces,​ ​villages,​ ​cities​​,​​and​

​more.​
​●​ ​Members​ ​of​ ​a​ ​society​ ​help,​ ​support,​ ​and​ ​respect​ ​each​ ​other​ ​to​

​maintain order and harmony.​

​Example:​

​●​ ​The​ ​people​ ​of​ ​a​ ​country​ ​form​ ​a​ ​society​​because​​they​​live​​under​​the​
​same government, follow laws, and share cultural and social values.​

​●​ ​Your​ ​school​ ​society​ ​is​ ​part​ ​of​ ​the​ ​larger​ ​society​ ​because​ ​students,​
​teachers, and staff follow rules and work together.​

​Types of Volunteering​

​●​ ​Environmental Volunteering:​​Planting trees, cleaning​​rivers​
​●​ ​Educational Volunteering:​​Teaching children, tutoring​
​●​ ​Health Volunteering:​​Blood donation, awareness about​​hygiene​
​●​ ​Social​ ​Volunteering:​ ​Helping​ ​poor,​ ​elderly,​ ​or​ ​differently-abled​

​people​

​Benefits:​

​Each​ ​type​ ​improves​ ​a​ ​specific​ ​part​ ​of​ ​the​ ​community​ ​and​ ​helps​ ​us​ ​learn​
​new skills.​

​Skills for Volunteering​

​●​ ​Teamwork:​​Work together with others​
​●​ ​Communication:​​Speak and listen clearly​
​●​ ​Empathy:​​Understand and care about others​
​●​ ​Leadership:​​Take responsibility and start helpful​​actions​
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​Why These Skills are Helpful:​

​●​ ​Makes us confident and responsible​
​●​ ​Helps us work well in groups​
​●​ ​Let’s us make a positive change in our community​

​Values Learned Through Volunteering​

​Important Values:​
​●​ ​Kindness:​​Care about others​
​●​ ​Respect:​​Treat everyone equally​
​●​ ​Responsibility:​​Do what you say you will do​
​●​ ​Compassion:​​Help those in need​

​How Values Help:​
​●​ ​Makes us better people​
​●​ ​Builds trust and friendship in society​
​●​ ​Encourages lifelong volunteering habits​

​How Volunteering Helps Us and the Community​
​For the Community:​

​●​ ​Makes places clean and safe​
​●​ ​Helps people in need​
​●​ ​Spreads awareness about important issues​

​For Ourselves:​

​●​ ​Builds confidence and leadership​
​●​ ​Teaches teamwork and empathy​
​●​ ​Gives happiness and a sense of responsibility​
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